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ΕΙΣΑΓΩΓΗ 

Το παρόν εγχειρίδιο συντάχθηκε ως εκπαιδευτικό υλικό, για κάλυψη των αναγκών του εργαστηρίου Μελέτη – Σχεδίαση με την χρήση Η/Υ στο 

Πολυτεχνείο Κρήτης. Το Siemens NX, πάνω στο οποίο βασίστηκε το εγχειρίδιο, είναι ένα λογισμικό CAD (Computer Aided Design), το οποίο 

χρησιμοποιείται για τη δημιουργία τρισδιάστατων μοντέλων στον Η/Υ. Τα μοντέλα αυτά αναφέρονται και ως εικονικά ή ψηφιακά μοντέλα, 

διότι κατά τη φάση της σχεδίασης υπάρχουν μόνο στον Η/Υ. Τα περισσότερα μοντέλα που σχεδιάζονται στο Siemens NX είναι μοντέλα 

στερεών, που σημαίνει ότι ο Η/Υ έχει πλήρη κατανόηση της τοπολογίας του αντικειμένου που σχεδιάζεται, δηλαδή πού υπάρχει υλικό και 

πού υπάρχει κενός χώρος. Οι σχεδιαστές στη στερεά μοντελοποίηση χρησιμοποιούν εντολές για τη σχεδίαση του μοντέλου, οι οποίες είναι 

παρόμοιες με τις φυσικές κατεργασίες, κατά τη φάση της παραγωγής, όπως η εξώθηση (Extrude = Σάρωση). Οι εντολές αυτές ονομάζονται 

μορφολογικά χαρακτηριστικά του μοντέλου (Model Features) και συνδυάζονται για τη δημιουργία εξαρτημάτων (Parts). Τα εξαρτήματα 

μπορεί να περιγράφονται από απλά ή πολύπλοκα σχήματα. 

Στο παρόν εγχειρίδιο παρουσιάζονται ορισμένες εντολές και λειτουργίες του Siemens NX, ώστε ο χρήστης να αποκτήσει βασικές γνώσεις σε 

αυτό το πρόγραμμα, αλλά και γενικότερα γύρω από την σχεδίαση με την χρήση Η/Υ. Στο εγχειρίδιο παρουσιάζεται αναλυτικά το Modeling, το 

Assembly, τα Drawings (Μηχανολογικά σχέδια) και συνοπτικά το Motion Simulation. Το Siemens NX παρέχει προφανώς πολύ περισσότερες 

δυνατότητες από αυτές που παρουσιάζονται εδώ, όπως το Sheet Metal Design για την δημιουργία αντικειμένων από μεταλλικά ελάσματα 

βασισμένη στη γνώση των ιδιοτήτων των υλικών και των διαδικασιών κατασκευής, free form modeling για την δημιουργία αντικειμένων πιο 

σύνθετης μορφής και ελεύθερα σχήματα. Εκτός από το CAD το Siemens NX 11 προφέρει δυνατότητες Manufacturing, CAM δηλαδή, 

ρομποτική μηχανική, υβριδικό manufacturing προγραμματισμό επιθεωρήσεων και σχεδιασμό εργαλείων. Επίσης με το Simcenter 3D δίνονται 

δυνατότητες προσομοίωσης αεροδυναμικής, στα ηλεκτρονικά, προσομοιώσεις  θορύβου, δονήσεων και τραχύτητας για τον χώρο της 

αυτοκίνησης  και καταγραφή και αυτοματοποίηση των διαδικασιών CAE.    
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SIEMENS NX 11 Design 

Το ΝΧ 11 της SIEMENS παρέχει μια μεγάλη γκάμα εργαλείων και σημαντικές δυνατότητες στο λειτουργικό του όντας ένα από τα πιο 

ανεπτυγμένα λογισμικά CAD. Το Design και το Manufacturing είναι σαφή και γρήγορα στην υλοποίησή τους ενώ αρκετές εργασίες έχουν 

αυτοματοποιηθεί. Θα παρουσιαστούν συνοπτικά τα κύρια τμήματα του λογισμικού που συνθέτουν το τμήμα του design (Μελέτη/Σχεδίαση) 

του ΝΧ11, ώστε ο χρήστης να κατανοήσει τις δυνατότητές που μπορεί να προσφέρει το λογισμικό και αν θέλει να ασχοληθεί μόνος του ώστε 

να επεκτείνει τις γνώσεις του. Τα τμήματα αυτά είναι: 

 

Feature Modeling: 

Το Siemens NX 11 δίνει τη δυνατότητα παραμετρικού μοντελοποίησης στερεών σωμάτων με την χρήση Μορφολογικών Χαρακτηριστικών 

(features). Πέρα από τα κλασσικά εργαλεία δημιουργίας features πρισματικής μορφής το ΝΧ παρέχει εργαλεία για την υλοποίηση τέτοιων 

πρότζεκτ όπως είναι το swept volume (σάρωση όγκου) κάνοντας σάρωση πάνω σε ένα στερεό σώμα, ακολουθώντας μια διαδρομή – οδηγό 

που μπορεί να είναι 2D ή 3D. O χρήστης έχει περισσότερες δυνατότητες και περισσότερες επιλογές για την διεκπεραίωση των πρότζεκτ. 

 

Surfacing: 

Το surface modeling παραμένει ένα από τα χρησιμότερα εργαλεία για τις περισσότερες εταιρίες, ιδιαιτέρως για τον βιομηχανικό σχεδιασμό 

και το styling. Στο ΝΧ 11 περιλαμβάνεται μια μεγάλη γκάμα εργαλείων για το surface modeling. Mε το curve scaling δίνεται η δυνατότητα 

δημιουργίας κλιμακωτών αντίγραφων των καμπυλών, των ακρών ή σημείων ως ένα νέο χαρακτηριστικό με την επιλογή της συσχέτισης με το 

αυθεντικό. Δίνεται η δυνατότητα ανάπτυξης μιας καμπύλης επιφάνειας, να γίνουν αλλαγές αλλά και η επιστροφή στο αρχικό της σχήμα. 

Δίνεται επίσης η δυνατότητα δημιουργίας ενός σώματος με συνεχές και μεταβαλλόμενο πάχος με μία μοναδική εργασία.   

 

 

5



Sheet Metal Design: 

To Sheet Metal Design είναι άλλη μια δυνατότητα που παρέχει το Siemens NX 11 σε μια πιο βελτιωμένη μορφή με ανανεωμένες και 

επαναδιατυπωμένες εντολές που συμπεριλαμβάνονται στο NX Advanced Sheet Metal. 

 

Synchronous Technology: 

Το synchronous technology δίνει στον χρήστη την δυνατότητα να εργαστεί σε κάθε μοντέλο, ανεξάρτητα της προέλευσής του, όπως επίσης 

την δυνατότητα να προσθέσει νοημοσύνη σε κάποια δεδομένα. Δίνεται η δυνατότητα αντικατάστασης μιας έδρας (face) με μια άλλη, η 

διαγραφή τους και ο διαχωρισμός ενός σώματος σε πολλαπλά σώματα.  

 

NX Realize Shape: 

To ΝΧ Realize Shape είναι ένα εργαλείο σχεδιασμού υποδιαίρεσης που χρησιμοποιεί έναν από χειρισμό σχήματος για την δημιουργία υψηλής 

ποιότητας B-surface και τελικά προϊόντα με πολύπλοκη μορφή. 

 

NX Layout: 

Το ΝΧ Layout είναι ένα 2D concept σχεδιαστικό εργαλείο που υποστηρίζει γρήγορο και ενστικτώδες concept design με πλήρη ενσωμάτωση 

και εύκολη και προσαρμογή στο 3D. 
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PMI: 

 To PMI χρησιμοποιείται για τον σχεδιασμό και την κατασκευή, για καλύτερη ποιότητα και έλεγχο. Η ταχύτερη πρόσβαση σε σημαντικές 

πληροφορίες παρέχει σημαντικά οφέλη σε σχέση με τις παραδοσιακές διαδικασίες που βασίζονταν στα drawings. 

 

Ενσωμάτωση Teamcenter και Active Workspace: 

To NX και το teamcenter είναι ενσωματωμένη στην έκδοση ΝΧ 11. Είναι πιο εύκολο για τους προμηθευτές και τα OEM να δουλεύουν μαζί. Το 

ΟΕΜ μπορούν να εξάγουν πρότυπα χαρακτηριστικών, δίνοντας την δυνατότητα στους προμηθευτές να χρησιμοποιούν τις ιδιότητες των 

πελατών τους για καλύτερη επικοινωνία και λιγότερα λάθη. 

 

High Performance Rendering:  

Στο Siemens NX 11 παρέχεται rendering τελευταίας τεχνολογίας, χάρη στην μηχανή Lightworks Iray+, ώστε να δίνεται η δυνατότητα στον 

χρήστη να δει πως μπορεί να είναι οπτικά ένα προϊόν πριν αυτό κατασκευαστεί. To φωτορεαλιστικό rendering βοηθά τον χρήστη να πάρει 

αποφάσεις αισθητικής ή λειτουργικής φύσεως αλλά και για το είδος των υλικών που θα χρησιμοποιηθούν, συμβάλλοντας με αυτόν τον 

τρόπο στην μείωση του κόστους. 

 

Point cloud processing: 

Το Point cloud data κάνει το Line design ευκολότερο και πιο εύστοχο. Το Siemens NX 11 δίνει την δυνατότητα εισαγωγής point cloud data σε 

ένα φάκελο με φορμάτ POD. Κάνει απλές μετρήσεις και αποδίδει λειτουργίες επεξεργασίας όπως το show/hide, την διαγραφή ή την 

επεξεργασία παραμέτρων. Με αυτόν τον τρόπο είναι ευκολότερη η πρόσβαση σε reference data χωρίς να είναι απαραίτητη η δημιουργία 3D 

data. 
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NX στο cloud: 

Για κάποιες διαμορφώσεις του ΝΧ 11 ο χρήστης έχει την δυνατότητα να τρέξει το NX σε ένα cloud-managed περιβάλλον. Έτσι ο χρήστης 

επωφελείται από τις νέες λειτουργίες του προγράμματος και τα cloud-based offerings, όπως η μειωμένη πολυπλοκότητα, λιγότερο χρόνο, 

μικρότερο κόστος και ρίσκο. 
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Το Siemens NX 11 στο simulation productivity 

Το Simcenter 3D  δίνει δυνατότητες προσομοίωσης και προβλέψεις στον χρήστη για την απόδοση του προϊόντος. Υπάρχει επίσης η 

δυνατότητα για την δημιουργία αναφορών των αποτελεσμάτων του simulation σε τυποποίηση Microsoft word. Επίσης το simcenter 3D 

προσφέρει ακουστικές δυνατότητες δίνοντας νέα διάσταση στην προετοιμασία ενός προϊόντος. Στο Simcenter 3D περιλαμβάνονται επίσης το 

cyclic symmetry για θερμικές και δομικές λύσεις, αξονοσυμμετρικές Fourier λειτουργίες. Στο Siemens NX 11 γίνεται επίσης η πρόβλεψη των 

καταπονήσεων και των παραμορφώσεων μετά από μια σειρά βημάτων του manufacturing και ακόμα προβλέπεται το πώς αυτές οι 

καταπονήσεις επηρεάζουν το μέλλον του προϊόντος. 

Το motion simulation είναι ένα ακόμα στοιχείο του προγράμματος το οποίο αποδίδει κίνηση σε έργα που έχουν δημιουργηθεί. Επίσης είναι 

δυνατή η πρόβλεψη της συμπεριφοράς ενός οχήματος μέσω της προσομοίωσης της συμπεριφοράς των ελαστικών και το είδος των δρόμων. 

Η επικάλυψη επιφανειών στο Simcenter 3D βοηθά στην γρήγορη δημιουργία της γεωμετρίας πεδίων ρευστού από ένα σύνθετο τμήμα 

γεωμετρίας και επίσης υπάρχει η δυνατότητα δημιουργίας τετραεδρικού – εξαεδρικού υβριδικού πλέγματος τρισδιάστατων στερεών 

στοιχείων σε επιλεγμένα σώματα. Επίσης μια νέα μορφή αρχείου JT που είναι διαθέσιμη στο Teamcenter υποστηρίζει περισσότερα CAE 

δεδομένα και μπορεί να εξάγει αρχεία σε αυτή την νέα μορφή. 
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ΝΧ CAM 

To Siemens NX 11 δίνει την δυνατότητα για Manufacturing Productivity με νέες τεχνολογίες software, βελτιώνοντας την παραγωγικότητα 

χάριν στην ρομποτική μηχανική και στην πρωτοποριακή κατασκευή υβριδικών πρόσθετων δυνατοτήτων. Επίσης με το Line Designer 

σχεδιάζονται  με γρήγορο τρόπο και με γραφικές απεικονίσεις γραμμές παραγωγής. Με το ΝΧ CAM παρέχονται οι δυνατότητες για Computer 

Aided Manufacturing, με καλύτερη χρήση των υλικών και των διαδρομών που θα ακολουθήσουν, βελτιστοποιώντας με αυτόν τον τρόπο την 

παραγωγική διαδικασία, κάνοντάς την ταχύτερη και αποτελεσματικότερη. 

Μία ακόμη δυνατότητα που παρέχει το ΝΧ είναι το CMM inspection programming καθώς μπορεί να προγραμματίσει αποτελεσματικά τον 

εξοπλισμό CMΜ και να διαβάσει τα αποτελέσματα πίσω στο ΝΧ για οπτική σύγκριση και ανάλυση. Τέλος το ΝΧ παρέχει σχεδιασμό εργαλείων 

προσφέροντας αυξημένη παραγωγικότητα κατά τον σχεδιασμό καλουπιών. Η ευέλικτη απεικόνιση υπολογιστικού φύλλου του Bill of 

Materials (BOM) διευκολύνουν την διαχείριση, την επεξεργασία και την ενημέρωση.  
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ΕΙΣΑΓΩΓΗ ΣΤΟ ΕΓΧΕΙΡΙΔΙΟ 

 

Το εγχειρίδιο αυτό έχει γραφτεί για την έκδοση Siemens NX 11.0, η οποία κυκλοφόρησε το 2016 και την στιγμή που γράφτηκε το παρόν 

εγχειρίδιο ήταν η πιο πρόσφατη έκδοση. Πάνω σ’ αυτή θα εκπαιδευτείτε στο εργαστήριο του μαθήματος Μελέτη-Σχεδίαση με Χρήση Η/Υ 

(CAD). Αρχικά εξηγεί, με μεγάλη λεπτομέρεια, τα βήματα για την δημιουργία των πρότζεκ/μοντέλων κατά την διάρκεια του εργαστηρίου, ενώ 

στην συνέχεια, οι οδηγίες είναι πιο συνοπτικές. Στις οδηγίες για την διεκπεραίωση των μοντέλων θα υπάρχουν εικόνες για την καλύτερη 

κατανόηση της διαδικασίας σχεδίασης.  

Στο πρώτο μέρος των Tutorial συμπεριλαμβάνεται η εκπαίδευση στον σχεδιασμό και την υλοποίηση 3D μοντέλων. Τα μοντέλα που θα 

σχεδιαστούν σε αυτό το μέρος έχουν ως στόχο την παρουσίαση των βασικότερων εντολών του προγράμματος, την εκπαίδευσή και την 

εξοικείωση σας με τις λειτουργίες του προγράμματος. Προφανώς οι δυνατότητες του προγράμματος είναι πολύ περισσότερες από αυτές που 

αναγράφονται στα Tutorial. 

Το δεύτερο μέρος του εγχειριδίου περιέχει σχεδιασμό και δημιουργία μοντέλων με τον τρόπο που διδαχθήκατε στο προηγούμενο tutorial. Σε 

αυτό το μέρος όμως οι οδηγίες που υπάρχουν για την διεκπεραίωση των εργασιών θα είναι πιο συνοπτικές γι’ αυτό κρίνεται απαραίτητη η 

πολύ καλή κατανόηση του πρώτου μέρους του εγχειριδίου. Τα τέσσερα μοντέλα που θα σχεδιαστούν σε αυτό το Tutorial θα 

χρησιμοποιηθούν για το Assembly, δηλαδή την συναρμολόγηση ενός τελικού μοντέλου. Γι’ αυτό χρειάζεται μεγάλη προσοχή στον σχεδιασμό 

και ιδιαίτερα στις διαστάσεις που θα δοθούν καθώς ένα λάθος στην δημιουργία των αρχικών μοντέλων μπορεί να δημιουργήσει πρόβλημα 

στο Assembly. 

Στο τρίτο μέρος των tutorial δεν θα ασχοληθούμε με τον σχεδιασμό αλλά θα υπάρξει αναλυτική επεξήγηση και εκπαίδευση στο assembly που 

είναι ουσιαστικά η συναρμολόγηση-σύνθεση των εξαρτημάτων που θα δημιουργήσουμε. Στο περιβάλλον του Assembly προσθέτουμε τα 

αντικείμενα με την εντολή Add  και δίνουμε λεπτομέρειες για την συναρμολόγηση με την εντολή Assembly Constraints . Θα 

χρησιμοποιηθούν οι βασικές εντολές για το Assembly και στην συνέχεια, αφού ολοκληρωθεί η συναρμολόγηση του μοντέλου, θα δοθεί 

κίνηση. 
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Στο τέταρτο μέρος των Tutorial συμπεριλαμβάνεται η δημιουργία των Drawings. Τα Drawings είναι τα μηχανολογικά σχέδια των μοντέλων 

που έχουμε σχεδιάσει και παρουσιάζονται και ακριβώς όπως έχετε διδαχθεί στο αντίστοιχο μάθημα της σχολής.  

Για την παρουσίαση των μηχανολογικών σχεδίων θα χρησιμοποιηθεί μορφή κόλλας Α3. 

Θα παρουσιάσουμε στο χαρτί τις τρεις βασικές όψεις ενός μοντέλου που σχεδιάσαμε αλλά και την τριμετρική (trimetric). Στο πάνω αριστερά 

μέρος θα βρίσκεται η πρόσοψη (Front), στο κάτω αριστερά η κάτοψη (Top), στο πάνω δεξιά η αριστερή πλάγια όψη (Left) και στο κάτω 

αριστερά η τριμετρική (trimetric). 

Στην συνέχεια θα ολοκληρωθεί το Drafting με την διαστασιολόγηση. 

Στο τέλος θα χρησιμοποιηθεί το Assembly που δημιουργήθηκε στα προηγούμενα tutorial για την δημιουργία του Exploded View του 

Assembly αλλά και τα Balloons. 

Στο 5ο μέρος των Tutorial θα γίνει συνοπτική αναφορά στο Motion Simulation δηλαδή στο πως γίνεται ένα μοντέλο να αποκτήσει κίνηση. Η 

εργασία που θα γίνει θα βασίζεται στο ήδη δημιουργημένο έμβολο που έχει σχεδιαστεί στο Tutorial 2 και συναρμολογηθεί στο Tutorial 3. Ένα 

έμβολο, σαν κι αυτό που δημιουργήθηκε, σε έναν κινητήρα μετατρέπει την παλινδρομική κίνηση σε περιστροφική. Για μεγαλύτερη 

διευκόλυνση εδώ θα γίνει το αντίστροφο. To αντικείμενο shaft θα είναι αυτό στο οποίο θα πάρει περιστροφική κίνηση η οποία θα γίνεται 

παλινδρομική, μέσω του rod, στο piston ενώ στην όλη διαδικασία θα συμμετέχουν και τα τέσσερα αντικείμενα που έχουν συναρμολογηθεί. 

Σε αυτό το κομμάτι χρησιμοποιούνται 2 βασικές λειτουργίες, την Link και την Joint. Η πρώτη εντολή όπως λέει και το όνομα της συνδέει δύο ή 

περισσότερα αντικείμενα μεταξύ τους. Εδώ θα χρησιμοποιηθεί τρεις φορές την Link, αλλά οι δύο φορές θα είναι για τον προσδιορισμό δύο 

μεμονωμένων αντικειμένων. Η εντολή Joint είναι αυτή η οποία δίνει το είδος της κίνησης ενός αντικειμένου ή των Links και τον τρόπο 

σύνδεσής τους με τα υπόλοιπα μέρη που απαρτίζουν το μοντέλο.  
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Ξεκινώντας το πρόγραμμα 

Κατά την διάρκεια του εργαστηρίου θα γίνει χρήση των πιο βασικών εντολών αυτού του προγράμματος. Στην επόμενη εικόνα βλέπουμε την 

καρτέλα Home, με τα κυριότερα ‘εργαλεία’ που χρησιμοποιούμε για την σχεδίαση. 

 

Στην καρτέλα του Home υπάρχουν εικονίδια ως συντομεύσεις που μας βοηθούν για τον σχεδιασμό. Υπάρχουν περισσότερα εργαλεία που 

μπορούμε να βρούμε και κάνουμε προσθαφαιρέσεις επιλέγοντας το More. Σε αυτή την καρτέλα εμπεριέχονται οι περισσότερες εντολές με 

τις οποίες θα ασχοληθούμε στα Tutorial. Όλες οι δυνατές επιλογές του προγράμματος βρίσκονται ανοίγοντας την επιλογή Menu που 

φαίνεται στο κάτω αριστερά μέρος της προηγούμενης εικόνας.  

Εκτός από το Home που είναι τα εργαλεία της σχεδίασης υπάρχουν κι άλλες καρτέλες. Η καρτέλα Assemblies χρησιμοποιείται για τις 

συναρμολογήσεις και συνδέσεις διάφορων μοντέλων σε ένα συνολικό αντικείμενο και εκεί υπάρχουν εντολές για προσθαφαίρεση 

αντικειμένων και τον τρόπο σύνδεσής τους.  

Στην καρτέλα Curve υπάρχουν εργαλεία σχεδίασης καμπυλών με περισσότερες επιλογές από ότι υπάρχουν στην καρτέλα του Home ώστε να 

παρέχονται όλες οι δυνατότητες στον χρήστη όσων αφορά την πολυπλοκότητα στην σχεδίαση των καμπυλών. 

Στην καρτέλα του Analysis συμπεριλαμβάνονται εργαλεία μέτρησης, εμφάνισης στοιχείων, σχήματος καμπυλών, σχήματος επιφανειών και 

απόκλισης – συνέχειας. 

Στην καρτέλα του View υπάρχουν επιλογές για την οπτική γωνία που βλέπουμε το μοντέλο αλλά και άλλες επιλογές όπως τον χρωματισμό 

του αλλά και την εμφάνιση των γραμμών – καμπυλών που έχουν σχεδιαστεί στο sketch. Αντίστοιχα επιλογές στην απεικόνιση του μοντέλου 

υπάρχουν και στην καρτέλα Render που και αυτή θα αναλυθεί συνοπτικά στην συνέχεια. 
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 Δημιουργείστε έναν φάκελο στην επιφάνεια εργασίας με το 

ονοματεπώνυμο σας καθώς εκεί θα αποθηκευτούν όλα τα 

μοντέλα που θα σχεδιάσετε στο εργαστήριο 

 Ξεκινάμε το πρόγραμμα από Start → Programs → NX 11.0 

 Επιλέγουμε File → New και εμφανίζετε το παρακάτω παράθυρο 

 Επιλέγουμε τις επιλογές που βλέπουμε στην εικόνα 1. Προσοχή 

στην σωστή επιλογή του φακέλου αποθήκευσης των αρχείων. 

 

 

 Πατάμε ΟΚ και εισερχόμαστε στο παράθυρο εργασίας 

 Το παράθυρο εργασίας έχει αυτή την μορφή (εικ 2). 
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TUTORIAL 1 

Model1 
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 Για να ξεκινήσουμε τον σχεδιασμό πατάμε πάνω δεξιά την 

επιλογή Sketch με αριστερό κλικ. 

 Κάνουμε κλικ (αριστερό κλικ) πάνω στο Datum YZ όπως 

φαίνεται και στην εικόνα 1.  

 Έπειτα πατάμε ΟΚ στο παράθυρο.  

 Στην συνέχεια επιλέγουμε με αριστερό κλικ το ορθογώνιο 

 (πάνω αριστερά στην οθόνη). Πηγαίνουμε κοντά 

στους άξονες, πατώντας μια φορά αριστερό κλικ ξεκινάμε να 

σχεδιάζουμε το ορθογώνιο και ξαναπατώντας αριστερό κλικ 

ολοκληρώνουμε την σχεδίασή μας. 

 Κλείνουμε το παράθυρο ‘Rectangle’. 

 Πατώντας διπλό κλικ στις πάνω στα νούμερα των διαστάσεων 

μπορούμε να δώσουμε στο ορθογώνιο τις διαστάσεις που 

θέλουμε. Δώστε αυτές που φαίνονται στην εικόνα 2. 

 Όπως βλέπετε δίνουμε 4 διαστάσεις. 2 για τις πλευρές του 

ορθογωνίου και άλλες 2 για την απόσταση των πλευρών από 

τους άξονες. 

 Τα ‘p0’, ‘p1’, ‘p2’ και ‘p3’  είναι απλά τα ονόματα των ακμών 

και δεν είναι απαραίτητο να είναι ίδια με τα δικά σας. 

 Η p1 είναι η οριζόντια ακμή, η p2 η απόσταση από το κέντρο 

των αξόνων όπως αντίστοιχα είναι οι p0 και p3. 

 

 
 

 
 

 

1 
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      H εντολή Extrude  

 Κάνουμε κλικ στην εντολή extrude  πάνω αριστερά στο 

tab των εντολών και εμφανίζεται το ακόλουθο παράθυρο (εικ 

3). 

 Η επιλογή select curve μας ζητά να επιλέξουμε το σχήμα στο 

οποίο θα εφαρμόσουμε το extrude, δηλαδή το ορθογώνιο που 

σχεδιάσαμε προηγουμένως στο sketch. Το ορθογώνιο που 

σχεδιάσαμε είναι μπλε. Εμείς κάνουμε αριστερό κλικ πάνω του 

ώστε να γίνει πορτοκαλί (έτσι φαίνεται ότι το έχουμε επιλέξει 

για το extrude). 

 Στον τομέα του Start προσέχουμε η επιλογή Distance να είναι 

0. Στον τομέα του End στην επιλογή Distance δίνουμε την τιμή 

200 που είναι το μήκος του extrude. Πατάμε ΟΚ για να 

ολοκληρωθεί η εντολή. Όπως βλέπετε στην εικόνα 4 στην 

καρτέλα Preview υπάρχει η επιλογή Show Result με την οποία, 

όπως φανερώνει το όνομα της, μπορούμε να βλέπουμε το 

αποτέλεσμα της εντολής πριν πατήσουμε ΟΚ και την 

ολοκληρώσουμε. Το Show Result υπάρχει και στις υπόλοιπες 

εντολές που θα δούμε. 

 Ολοκληρώσαμε την πρώτη μας εντολή. Τώρα πατάμε Home 

στο πληκτρολόγιο ή δεξί κλικ → Orient View → Trimetric ώστε 

να βλέπουμε το αντικείμενο μας πιο καλά, στην τριμετρική 

όψη, όπως στην εικόνα 4.  

 

 

 

3 
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     Η εντολή Edge Blend 

 

 Με την εντολή αυτή θα δώσουμε καμπύλη μορφή σε δύο 

ακμές του μοντέλου που έχουμε σχεδιάσει 

 Επιλέγουμε την εντολή αυτή κάνοντας κλικ πάνω στο εικονίδιο 

της  και μας εμφανίζεται το παράθυρο του Edge Blend. 

 Τώρα επιλέγουμε δύο ακμές του αντικειμένου μας κάνοντας 

αριστερό κλικ πάνω τους (εικ 5) 

 Δίνουμε την τιμή 10 στο Radius (ακτίνα) και πατάμε ΟΚ ώστε να 

ολοκληρωθεί το Edge Blend. Κλείνουμε στην συνέχεια το 

παράθυρο ‘Edge Blend’. (εικ 6). 
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      H εντολή Chamfer  

 

 Πατάμε Home ώστε να βλέπουμε καλύτερα το αντικείμενό μας. 

 Κάνουμε κλικ στην εντολή Chamfer,  που είναι 

δίπλα από την εντολή Edge Blend, και όπως πριν επιλέγουμε 

μια ακμή στο αντικείμενο μας ώστε ν εφαρμοστεί η εντολή. 

Επιλέγουμε την ακμή που φαίνεται στην εικόνα 7. 

 Στο Distance δίνουμε την τιμή 20, πατάμε ΟΚ και μετά 

κλείνουμε το παράθυρο του Chamfer. 

 To μοντέλο μας θα είναι όπως στην εικόνα 8. 
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Η εντολή Hole  
 

 Με αυτή την εντολή μπορούμε να δημιουργήσουμε οπές στο 

αντικείμενο που έχουμε σχεδιάσει. 

 Πατάμε Home ώστε να βλέπουμε καλά το αντικείμενό μας. 

Κάνουμε κλικ στην εντολή Hole . Μετά πάμε τον 

κέρσορα στην κόκκινη πλευρά που φαίνεται στην παρακάτω 

εικόνα 9 και κλικάρουμε πάνω της. Με αυτόν τον τρόπο 

επιλέγουμε το επίπεδο που θα κάνουμε την οπή. 

 Όταν κάνουμε κλικ πάνω στην πλευρά οδηγούμαστε αυτόματα 

στο sketch όπου θα σχεδιάσουμε την οπή και βλέπουμε ότι 

υπάρχουν δύο διαστάσεις οι οποίες δίνουν το κέντρο του 

κύκλου της οπής. Κλείνουμε το παράθυρο “Sketch Point”.  

 Mε διπλό κλικ πάνω στον αριθμό μιας διάστασης, δίνουμε την 

τιμή της. Πατάμε Enter ώστε να κατοχυρωθεί η τιμή της 

διάστασης. Κάνουμε το ίδιο και για τις δύο διαστάσεις δίνοντας 

τις τιμές που βλέπετε στην εικόνα 10. Πατάμε Finish Sketch 

ώστε να βγούμε από το sketch.  
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 Έχοντας βγει από το sketch υπάρχει το παράθυρο του Hole στο 

οποίο θα εργαστούμε για να ολοκληρώσουμε την εντολή. 

 Στο Type υπάρχουν διάφορα ήδη οπών με τα περισσότερα να 

έχουνε ήδη προκαθορισμένη διάμετρο ή βάθος. 

 Εμείς επιλέγουμε General Hole. Στο Form υπάρχουν και εκεί 

κάποιες επιλογές με τις οποίες δεν θα ασχοληθούμε 

αναλυτικά. Κρατάμε την επιλογή Simple. 

 Στην καρτέλα του Dimensions δίνουμε διάμετρο (Diameter) και 

βάθος (Depth). Στη διάμετρο του κύκλου δίνουμε την τιμή 20. 

Επειδή η οπή θέλουμε να γίνει κατά μήκος όλου το σώματος 

του αντικειμένου στο Depth Limit, πατάμε στο βελάκι δίπλα 

από Value και επιλέγουμε Through Body. Αν θέλαμε η οπή να 

γίνει μέχρι ενός σημείου μέσα στο σώμα του αντικειμένου θα 

δίναμε τις αντίστοιχες τιμές στο Value. Συμβουλευτείτε την 

εικόνα 11. 

 Πατάμε ΟΚ και έτσι ολοκληρώνουμε την εντολή hole και το 

αντικείμενό μας είναι όπως στην εικόνα 12. 

  11 12 
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    Η εντολή Mirror feature 
 
 Με αυτή την εντολή θα δημιουργήσουμε μια ίδια οπή στο 

άλλο σημείο του αντικειμένου. 

 Επιλέγουμε την εντολή Mirror feature κάνοντας κλικ στο 

More  και μετά στην εντολή Mirror feature.  

 Κάνουμε κλικ στο Select Feature και μετά κλικ στην οπή (εικ 

13). 

 Στο παράθυρο που εμφανίστηκε πατάμε New Plane, και 

μετά πατάμε Specify plane.  

 Κάνουμε κλικ στην πορτοκαλί πλευρά που βλέπετε στην 

εικόνα 13. Υπάρχει περίπτωση να εμφανιστεί ένα παράθυρο 

με όνομα Quickpick στο οποίο θα υπάρχουν δύο επιλογές. 

Επιλέξτε αυτή που θα σας δίνει την πλευρά που βλέπετε 

στην εικόνα 14. 

 Δίνουμε την τιμή -100. Η τιμή -100 που δώσαμε είναι η 

απόσταση που έχει το New Plane από την πλευρά που 

επιλέξαμε. Αν δίναμε την τιμή 100 το New Plane θα 

δημιουργούταν έξω από το αντικείμενό σε απόσταση 100 

από την πορτοκαλί πλευρά της εικόνας.   

 Πατάμε ΟΚ και η δεύτερη οπή έχει δημιουργηθεί (εικ 15). 

 Ουσιαστικά για την εντολή Mirror Feature χρησιμοποιήσαμε 

ένα νέο Plane ως άξονα συμμετρίας ώστε να κάνουμε κάτι 

σαν copy paste μιας προηγούμενης εργασίας στο 

αντικείμενο που σχεδιάζουμε. 
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    Η εντολή Pattern feature 

 Πατάμε sketch και επιλέγουμε την πλευρά που βλέπουμε 

στην εικόνα 16 και πατάμε ΟΚ. 

 Σχεδιάζουμε έναν κύκλο και δίνουμε τις διαστάσεις όπως 

στην εικόνα 17. 

 Πατάμε finish sketch. 

 Επιλέγουμε τον μικρό κύκλο που σχεδιάσαμε και κάνουμε 

extrude με Distance (ύψος) 50 (εικ 18). 
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 Τώρα πατάμε την επιλογή Pattern feature. Προσοχή στα 

βήματα. Αρχικά στο Select Feature επιλέγουμε το 

αντικείμενο που θα κάνουμε Pattern που είναι ο κύλινδρος 

που σχεδιάσαμε πριν (εικ 19). 

 

 Στο Layout επιλέγουμε Linear (Pattern σε ευθεία γραμμή). 

 Στο Specify Vector πρέπει να δείξουμε ποιο είναι διάνυσμα 

που θα γίνει το Pattern. Κάνουμε αριστερό κλικ στο Specify 

Vector και μετά αριστερό κλικ στον άξονα x όπως στην 

εικόνα 20. 

 Στο Count επιλέγουμε 5, στο Pitch Distance βάζουμε 20mm. 

(Συμβουλευτείτε την εικόνα 20). 

 Πατάμε ΟΚ και το αποτέλεσμά μας θα είναι όπως στην 

εικόνα 21. 
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 Όπως παρατηρήσατε στο Pattern Feature, κάνουμε κάτι σαν 

ένα copy-paste ενός αντικειμένου που έχουμε σχεδιάσει. 

Εδώ φτιάξαμε έναν κύλινδρο, του οποίου δημιουργήσαμε 

άλλα 4 αντίγραφα (5 σε σύνολο (count)) κατά μήκος μιας 

ευθείας (Linear). Η εντολή αυτή είναι από τις πιο χρήσιμες 

του προγράμματος και όπως θα παρατηρήσατε έχει πολλές 

επιλογές για να μπορούμε να την χρησιμοποιούμε στα 

διαφορετικού είδους “copy-paste” που θα χρειαστεί να 

κάνουμε σε ένα πρότζεκτ. 

 Η πρώτη άσκηση στο Siemens NX ολοκληρώθηκε. Κάνοντας 

save  αρχείο σώζεται στο folder που ορίσατε όταν 

ανοίξατε το πρόγραμμα 

 Σε αυτό το σημείο χρησιμοποιείστε το μοντέλο που μόλις 

ολοκληρώσατε για να δείτε μερικές λειτουργίες του 

προγράμματος.  
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Καρτέλα VIEW 
 

 Orientation:  

 Με τις επιλογές αυτές αλλάζουμε την οπτική γωνία που βλέπουμε το μοντέλο (πρόοψη, κάτοψη, δεξιά πλάγια όψη, 

τριμετρική κτλ). Οι επιλογές αυτές υπάρχουν και σε συντόμευση στο πληκτρολόγιο. 

 

 Κάνοντας scroll με την ροδέλα του ποντικιού μπορούμε να κάνουμε zoom in και zoom out. Μπορούμε να περιστρέψουμε το μοντέλο 

πιέζοντας και κρατώντας πατημένη την ροδέλα του ποντικιού. Πιέζοντας και κρατώντας πατημένη την ροδέλα μαζί με το πλήκτρο shift 

μετακινούμε το μοντέλο χωρίς να το περιστρέψουμε. 

 

  Mε την επιλογή Show and Hide μπορούμε να επεξεργαστούμε το τι βλέπουμε στο μοντέλο (sketch, datum κτλ). 

 

  Με την επιλογή αυτή μπορούμε να βλέπουμε το μοντέλο σε τομή κάτι που είναι αρκετά χρήσιμο σε πολύπλοκα μοντέλα. 

 

  Κι άλλες επιλογές για το στυλ που βλέπουμε το μοντέλο. Επιλέξτε τις για να δείτε τις διαφορές. 
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 Για τον χρωματισμό επιλέγουμε το Edit Object Display. Επιλέγουμε το αντικείμενο μας, πατάμε ΟΚ, και ανοίγει ένα 

καινούριο παράθυρο από όπου μπορούμε να αλλάξουμε το χρώμα του αντικειμένου που επιλέξαμε. 

 

 

Καρτέλα Render 
 

 Το Render είναι μια καρτέλα που υπάρχει στο κυρίως tab μαζί με τα Home, Assemblies κτλ. Μας δίνει την δυνατότητα να αλλάξουμε 

τις γραφικές απεικονίσεις του μοντέλου. Ας δούμε κάποιες λειτουργίες του. 

 Επιλέγουμε την καρτέλα του Render και μετά πατάμε αριστερό κλικ στο True Shading. 

 Στο True Shading Setup μπορούμε να αλλάξουμε το material στο μοντέλο, γραφικές απεικονίσεις του φόντου πίσω από το μοντέλο 

αλλά και την δημιουργία σκιών από το μοντέλο και γραφικές επιλογές στο floor που βρίσκεται αυτό.  
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           Model 2 
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Η εντολή Revolve 
 

 Ανοίγουμε το sketch με CSYS το Datum YZ. 

 Με την χρήση του Profile   σχεδιάζουμε το σχημα της 

είκονας 1. 

 Πιθανόν όταν φτίαξετε το σχήμα, το πρόγραμμα να σας 

εμφανίζει διαφορετικές διαστάσεις από αυτές που βλέπετε 

στην εικόνα 1. Έτσι στο σημείο αυτό θα δούμε πως 

μπορούμε να αλλάξουμε την διαστασιολόγηση στο σχήμα 

μας. 

 Στην καρτέλα των εντολών υπάρχει η εντολή Rapid 

Dimension . Αν πατήσετε στο βελάκι θα δείτε ότι θα 

εμφανιστούν κι άλλες επιλογές για τις διαστάσεις. 
1) Rapid Dimension: Επιλέγουμε με τον κέρσορα δύο σημεία ( ή 

ευθείες) για να μας δώσει την διάσταση 
2) Linera Dimension: Μας δίνει την διάσταση ενός ευθύγραμμου 

τμήματος. 
3) Radial Dimension: Μας δίνει την διάσταση τόξων. 
4) Angylar Dimension: Μας δίνει τις μοίρες μιας γωνίας. 
5) Perimeter Dimension: Μας δίνει την περίμετρων 
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 Ας υποθέσουμε ότι κάναμε το σχήμα και έχουμε τις 

ακόλουθες διαστάσεις της εικόνας 2. Όπως ειπώθηκε πιο 

πριν οι διαστάσεις έχουν δοθεί αυτόματα από το 

πρόγραμμα. Γι’ αυτό δώστε προσοχή ώστε να καταλάβετε 

την διαδικασία και να κάνετε τις απαραίτητες αλλαγές στο 

δικό σας πρότζεκτ. 

 Πρώτα αλλάζουμε την πάνω οριζόντια ακμή. Πατάμε διπλό 

αριστερό κλικ πάνω στον αριθμό της διάστασης, δίνουμε 

την τιμή 250 και πατάμε enter. To σχήμα μας μπορεί να 

αλλάζει σε μεγάλο βαθμό καθώς δίνουμε διαστάσεις. Αυτό 

δεν μας πειράζει καθώς αν δώσουμε σωστά τις τιμές των 

διαστάσεων δεν θα υπάρχει πρόβλημα. 

 Τώρα επιλέγουμε την ακμή που έχει τιμή 210. Πάλι κάνουμε 

διπλό κλικ πάνω στον αριθμό, δίνουμε την τιμή 200 και 

πατάμε enter. 

 Επιλέγουμε τώρα την ακμή που έχει τιμή 35 και με την ίδια 

διαδικασία δίνουμε την τιμή 250. 

 Το σχήμα μας είναι όπως στην εικόνα 3. 
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 Τώρα θα χρησιμοποιήσουμε την εντολή στην οποία 

αναφερθήκαμε προηγουμένως. Επιλέγουμε Angular 

Dimension και επιλέγουμε τις ακμές που βλέπετε στην 

εικόνα 4. Εμφανίζεται η τιμή της διάστασης στο σχήμα. 

Σύρουμε τον κέρσορα ώστε να έρθει σε ένα σημείο που να 

την βλέπουμε καθαρά και πατάμε αριστερό κλικ. Δίνουμε 

την τιμή 60 και πατάμε enter. Αν πατήσουμε αριστερό κλικ 

στην τιμή της διάστασης και το κρατήσουμε πατημένο 

μπορούμε να σύρουμε και να επανατοποθετήσουμε την 

τιμή της σε σημείο που να φαίνεται πιο καθαρά 

 Υπάρχει η περίπτωση να σας εμφανιστεί ένα μήνυμα ότι 

έχετε βάλει περισσότερες διαστάσεις από όσες χρειάζεστε 

και οι περιττές αυτές διαστάσεις να έχουν χρώμα κόκκινο. 

(βλ. εικόνα 5). Σε αυτή την πατάμε αριστερά κλικ σε μία 

από αυτές τις διαστάσεις και την διαγράφουμε πατώντας 

delete. 

 Το σχήμα μας είναι όπως στην εικόνα 6. 

 

 

 

 

 

   

  

4 5 

6 

31



 Πατάμε Finish Sketch . 

 Κάνουμε κλικ την εντολή Revolve . Αν δεν την βλέπετε 

απλά κάντε κλικ στο βελάκι κάτω από το extrude και 

επιλέξτε την. 

 Κάνουμε κλικ στο revolve και εμφανίζεται το ακόλουθο 

παράθυρο της εικόνας 7.  

 Στο Select Curve επιλέγουμε το σχήμα που σχεδιάσαμε.  

 Έπειτα κάνουμε κλικ στο Specify Vector και επιλέγουμε την 

κόκκινη γραμμή που βλέπετε στην εικόνα 8. Πατάμε ΟΚ. 

 Το μοντέλο μας είναι όπως στην εικόνα 9. 
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        Η εντολή Shell 

 

 Κάνουμε κλικ πάνω στην εντολή Shell . Στο 

παράθυρο που εμφανίστηκε βάζουμε Thickness 20. 

Προσοχή όταν χρησιμοποιείτε υποδιαστολή να βάζετε την 

τελεία (.).  Κλικάρουμε την επιφάνεια που φαίνεται στην  

εικόνα 10 και πατάμε ΟΚ. 

 

 Έτσι δημιουργήσαμε το αντικείμενο της εικόνας 11. 
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 Υπάρχει η δυνατότητα να αλλάξουμε ή να διορθώσουμε κάτι 

στο αντικείμενο μας σε κάποιες ενέργειες που είχαμε κάνει 

αρχικά. Για παράδειγμα ας πάμε να κάνουμε μια αλλαγή σε 

αυτό το μοντέλο. 

 Στο tab που βρίσκεται στο αριστερό άκρο κάνουμε κλικ στο 

Part Navigator  και στην συνέχεια διπλό κλικ στο Sketch 

(1). (Το Sketch (1) υπάρχει πιθανότητα να έχει άλλο όνομα 

στην δικιά σας εργασία). (εικ 12). 

 Βρισκόμαστε τώρα στο Sketch που σχεδιάσαμε στην αρχή 

(εικ 13). 
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 Στην καρτέλα curve 

επιλέγουμε την εντολή Fillet  .στο παράθυρο fillet 

method που άνοιξε, επιλέγουμε Trim και στην συνέχεια 

επιλέγουμε τα δυο ευθύγραμμα τμήματα που φαίνονται 

στην εικόνα 14. 

 Δίνουμε την τιμή 450 (που είναι η ακτίνα), πατάμε enter, 

Finish sketch και το νέο αντικείμενό μας είναι όπως στην 

εικόνα 15. 
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    Model 3 
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 Πατάμε την επιλογή Sketch, και όπως και στα προηγούμενα 

μοντέλα επιλέγουμε να σχεδιάσουμε στο datum YZ. 

 Σχεδιάζουμε ένα ορθογώνιο που απέχει 20 από τον άξονα χ 

με τις διαστάσεις της εικόνας 1. 
 Πατάμε finish sketch. 

 Πατάμε την εντολή Revolve. Στο select curve επιλέγουμε το 

ορθογώνιο και στο  

 Στο Specify Vector τον Υ Axis (εικ 2). 

 Στο Specify Point την αρχή των αξόνων (εικ 3). 

 Το μοντέλο μας θα είναι όπως στην εικόνα 4. 
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 Πατάμε πάλι την επιλογή sketch και διαλέγουμε πάλι το YZ 

Datum. 

 Σχεδιάζουμε τα ορθογώνια που βλέπετε στην εικόνα 5. 

Θυμηθείτε πως αν κάνετε κλικ και το κρατήσετε πατημένο 

μπορείτε να σύρετε τους αριθμούς των διαστάσεων ώστε να 

είναι πιο ευδιάκριτοι. Επίσης θυμηθείτε πως με δεξί κλικ → 

Orient View → και όποια άλλη επιλογή βάλετε αλλάζετε 

την οπτική γωνία. Εδώ σχεδιάζουμε με την επιλογή Right. 

Όταν τελειώσουμε τον σχεδιασμό πατάμε finish sketch. 

 Τώρα επιλέγουμε την εντολή revolve. Στο παράθυρο του 

revolve, στο Select curve κάνουμε κλικ τα ορθογώνια που 

σχεδιάσαμε. Μπορούμε επίσης να επιλέξουμε τα ορθογώνια 

κάνοντας κλικ στο αντίστοιχο sketch από το Tab το Part 

Navigator.  Ακριβώς όπως πριν στο Specify vector 

επιλέγουμε τον Y-Axis και στο Specify Point την αρχή των 

αξόνων. 

 Στο Boolean κάνουμε κλικ στο βελάκι και επιλέγουμε 

Subtract. Τέλος πατάμε ΟΚ (συμβουλευτείτε την εικόνα 6). 
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 Το μοντέλο μας θα είναι όπως στην εικόνα 6. 

Παρατηρούμε πως κάναμε Revolve με αφαίρεση υλικού. 

Ομοίως μπορούμε να χρησιμοποιήσουμε και την εντολή 

extrude. 

 Επιλέγουμε τώρα την εντολή Hole και επιλέγουμε την 

κόκκινη επιφάνεια της εικόνας 7. 

 

 

 

 

 

 

 

 
 

 

6 

7 

39



 Όταν κάνουμε κλικ πάνω στην πλευρά οδηγούμαστε αυτόματα 

στο sketch (εικ 8) όπου θα σχεδιάσουμε την οπή και βλέπουμε 

ότι υπάρχουν ένας πράσινος σταυρός που δείχνει το κέντρο 

της οπής και δύο διαστάσεις οι οποίες καθορίζουν που θα 

βρίσκεται το κέντρο της οπής. Κλείνουμε το παράθυρο “Sketch 

Point”.  

 Mε διπλό κλικ πάνω στον αριθμό μιας διάστασης, δίνουμε την 

τιμή της. Πατάμε Enter ώστε να κατοχυρωθεί η τιμή της 

διάστασης. Κάνουμε το ίδιο και για τις δύο διαστάσεις δίνοντας 

τις τιμές που βλέπετε στην εικόνα 8. Πατάμε Finish Sketch ώστε 

να βγούμε από το sketch.  
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 Πατώντας Finish Sketch εμφανίζεται το παράθυρο της 

εικόνας 9. Αυτό γίνεται γιατί η εντολή Hole δεν έχει 

ολοκληρωθεί ακόμα. Προηγουμένως καθορίσαμε που θα 

ήταν το κέντρο της οπής τώρα θα δώσουμε κι άλλες 

λεπτομέρειες για την οπή όπως διάμετρο, βάθος κτλ. Δώστε 

ότι βλέπετε στην εικόνα 9. Πατήστε ΟΚ και το μοντέλο θα 

είναι όπως στην εικόνα 10. 
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 Τώρα θα κάνουμε ένα Pattern στην οπή που μόλις 

δημιουργήσαμε. Πατάμε την επιλογή Pattern Feature και 

μας εμφανίζεται το παράθυρο της εντολής. (Συμβουλευτείτε 

την εικόνα 11). Στο Select feature διαλέγουμε την οπή 

(simple hole) που δημιουργήσαμε πριν. Στο Layout 

επιλέγουμε circular. Στο Specify Vector επιλέγουμε τον Y-

Axis όπως προηγουμένως. Στο Specify Point επιλέγουμε την 

αρχή των αξόνων Στο Spacing επιλέγουμε count and pitch, 

στο count βάζουμε 4 και στο pitch angle 90. Πατάμε ΟΚ. 

 

 Το μοντέλο μας είναι όπως στην εικόνα 12. 
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 Τώρα θα κάνουμε ένα Mirror ταυτόχρονα στις εργασίες που 

έχουμε κάνει. 

Κάνουμε κλικ στην εντολή Mirror και στην γραμμή εργασιών 

κάνουμε κλικ, έχοντας πατημένο το ctrl στα δύο Revolve, 

στο hole και στο Pattern (δείτε εικόνα 13) 

 Στο specify plane κλικάρουμε στο βελάκι και επιλέγουμε 

Inferred με Distance 0, και επιλέγουμε το plane XZ όπως 

βλέπετε στην εικόνα 14.  

 Πατάμε ΟΚ και το Mirror ολοκληρώθηκε (εικ 15).  
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Screw
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 Δημιουργούμε ένα καινούριο αρχείο το οποίο ονομάζουμε 

screw.prt 

 Πατάμε Sketch και επιλέγουμε επίπεδο σχεδίασης το XY. 

 Με το εργαλείο Polygon   σχεδιάζουμε ένα πολύγωνο 

όπως στην εικόνα 1. 

 Πατάμε finish sketch. 

 Κάνουμε extrude το πολύγωνο για 7 και το μοντέλο μας 

είναι όπως στην εικόνα 2. 
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 Επιλέγουμε πάλι sketch και επιλέγουμε επίπεδο σχεδίασης 

το XY πάλι. 

 Σχεδιάζουμε έναν κύκλο διαμέτρου 12 όπως στην εικόνα 3. 

 Κάνουμε finish sketch και κάνουμε extrude τον κύκλο για 0. 

 Προσέξτε το Direction του extrude ώστε όταν πατάτε 

“Home” από το πληκτρολόγιο (δηλαδή να βλέπετε το 

μοντέλο στην τριμετρική όψη) να είναι όπως στην εικόνα 4.  
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 Πατάμε πάλι sketch και επιλέγουμε επίπεδο σχεδίασης το 

ΧΖ. 

 Κάνουμε zoom in με την ροδέλα του ποντικιού για να 

μπορούμε να σχεδιάσουμε πιο άνετα και με το εργαλείο 

Profile σχεδιάζουμε ένα τρίγωνο όπως στην εικόνα 5. 

 Πατάμε finish sketch. Τώρα θα κάνουμε Revovle το τρίγωνο 

που σχεδιάσαμε. Προσοχή στα βήματα. 

 Επιλέγουμε την εντολή Revolve. 

 Στο Section στο Select Curve επιλέγουμε το τρίγωνο. 

 Στο Axis στο specify Vector επιλέγουμε τον άξονα Ζ. 

 Στο Boolean επιλέγουμε Subtract και στο Select Body 

επιλέγουμε το πολύγωνο της εικόνα 6. 

 Πατάμε ΟΚ και το μοντέλο είναι όπως στην εικόνα 7.  

 

 

 

 
 

5 

6 

7 

47



 Στο More επιλέγουμε την εντολή thread  

 Επιλέγουμε detailed. 

 Κάνουμε αριστερό κλικ χαμηλά στην επιφάνεια της εικόνας 

8 ώστε το βέλος να έχει φορά όπως στην εικόνα 8. 

 Αλλάζουμε μόνο την τιμή του Length όπου δίνουμε την τιμή 

15 και πατάμε ΟΚ. 

 Το μοντέλο είναι όπως στην εικόνα 9 και έχει ολοκληρωθεί. 
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ΑΛΛΕΣ ΧΡΗΣΙΜΕΣ ΕΝΤΟΛΕΣ 

H εντολή Tube με σχεδιασμό Helix 
 Με αυτή την εντολή θα μπορούμε να σχεδιάσουμε μοντέλα 

με ελικοειδή μορφή, όπως το ένα ελατήριο 

 Στο βασικό tab του προγράμματός μας πατάμε πάνω στο 

curve και έπειτα επιλέγουμε την εντολή helix.  

 Έτσι δημιουργείται το σχήμα της εικόνας 1 το οποίο θα 

αφήσουμε όπως είναι και δεν θα αλλάξουμε διαστάσεις. 

 Τώρα ακολουθείστε τα βήματα της εικόνας 2 ώστε να 

προσθέσουμε στο Μore κάποιες εντολές που δεν τις 

συμπεριλαμβάνει η καρτέλα. Πατάμε το βελάκι για να 

ανοίξει το feature, πάμε More Gallery και κλικάρουμε μία 

φορά στο Sweep Gallery.  
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 Πατάμε τώρα στο More και επιλέγουμε την εντολή Tube. 

 Ανοίγει το παράθυρο το tube. Στο Select Curve επιλέγουμε 

την γραμμή που σχεδιάσαμε, δίνουμε τις διαστάσεις που 

θέλουμε και πατάμε ΟΚ. 

 Το μοντέλο μας θα είναι όπως αυτό της εικόνας 3. 
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             Η εντολή Sweep Along Guide 

 Πατάμε Sketch και επιλέγουμε το ΧΥ Plane όπως στην 

εικόνα 1 και πατάμε ΟΚ. 

 Σχεδιάζουμε με το Line μια ευθεία γραμμή με μήκος 50 

όπως στην εικόνα 2. 

 Επιλέγουμε Arc  για να σχεδιάσουμε ένα ημικύκλιο. 

Κλικάρουμε το σημείο στο τέλος του ευθύγραμμου 

τμήματος που σχεδιάσαμε αρχικά και κάνουμε δεύτερο 

αριστερό κλικ σε ένα άλλο σημείο όπως στην εικόνα 3. 

 Κλείνουμε το παράθυρο του Arc και με διπλό κλικ πάνω 

στις διαστάσεις δίνουμε τις τιμές της εικόνας 4. 

 Πατάμε finish sketch. 
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 Πατάμε Home στο πληκτρολόγιο ώστε να βλέπουμε το 

σχέδιο καλύτερα. 

 Τώρα πατάμε πάλι Sketch και επιλέγουμε το ΥΖ Plane. 

 Σχεδιάζουμε έναν κύκλο με την εντολή Circle. Κλείνουμε το 

παράθυρο του Circle και του δίνουμε διάμετρο 2 και 

πατάμε finish sketch. (εικ 5) 

 Έχοντας βγει από το sketch πατάμε Home, πάμε στο More 

και επιλέγουμε την εντολή Sweep Along Guide 

 την οποία θα βρείτε στις εντολές που 

περιλαμβάνονται στο More. 

 Στον τομέα του Section για Select Curve επιλέγουμε τον 

κύκλο 

 Στον τομέα Guide την γραμμή που σχεδιάσαμε και πατάμε 

ΟΚ. 

 Το μοντέλο μας θα είναι όπως στην εικόνα 6. 
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            Η εντολή Swept 

 Σε ένα νέο αρχείο πάλι πατάμε Sketch και επιλέγουμε 

datum plane για τον σχεδιασμό το ΥΖ 

 Σχεδιάζουμε ένα ορθογώνιο με διαστάσεις όπως στην 

εικόνα 1 και πατάμε finish sketch 

 Βγαίνουμε από το sketch και πατάμε Home. Θέλουμε τώρα 

να φτιάξουμε ένα καινούριο plane.Πατάμε Datum Plane  

κάνουμε κλικ πάνω στο Plane ΥΖ, και δίνουμε την τιμή 50 

στο distance (εικ 2) και πατάμε ΟΚ. 

 Κάνουμε κλικ και πάλι στο Sketch αλλά τώρα επιλέγουμε 

για datum plane που θα σχεδιάσουμε το Plane που 

φτιάξαμε προηγουμένως. 

 Κατασκευάζουμε ένα ορθογώνιο πάλι με τις διαστάσεις της 

εικόνας 3. 
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 Πατάμε πάλι το sketch και επιλέγουμε το Datum plane ΧΥ. 

 Σχεδιάζουμε με το Line μια γραμμή όπως στην εικόνα 4 και 

πατάμε finish sketch 

 Τώρα κάνουμε κλικ στο More και επιλέγουμε την εντολή 

Swept. 

 Προσοχή στα βήματα. Καθώς πατήσαμε την εντολή άνοιξε 

το παράθυρο του swept. Κάνουμε αριστερό κλικ σε μια 

ακμή του μεγάλου ορθογωνίου να την επιλέξουμε και μετά 

πατάμε δεξί κλικ πάνω της και επιλέγουμε Connected 

Curves. Έτσι επιλέγουμε όλο το ορθογώνιο 

 Στο παράθυρο του Swept πατάμε το εικονίδιο στο Add New 

Set  και κλικάρουμε πάνω στο μικρό ορθογώνιο. 

 Έχουμε δώσει στα Select Curves του Sections τα δύο 

ορθογώνια του Swept. 

 Κάνουμε κλικ στο Select Curves στον τομέα του Guides και 

κλικάρουμε πάνω στην ευθεία που ενώνει τα ορθογώνια. 

Έτσι δίνουμε τον «οδηγό» του Swept. (εικ 5) 

 Πατάμε ΟΚ και το μοντέλο μας είναι όπως στην εικόνα 6. 
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             Η εντολή swept (2)  

 

 Πατάμε sketch και επιλέγουμε το ΧΥ Datum Plane και 

σχεδιάζουμε έναν κύκλο διαμέτρου 40, με κέντρο την αρχή 

των αξόνων. Πατάμε finish sketch. 

 Δημιουργούμε ένα Datum Plane  παράλληλο στο ΧΥ σε 

απόσταση 20 από το ΧΥ. (εικ 1) 

 Επιλέγουμε sketch και επιλέγουμε να σχεδιάσουμε πάνω 

στο Plane που μόλις δημιουργήσαμε. 

 Σχεδιάζουμε έναν κύκλο με κέντρο που περνά από την αρχή 

των αξόνων με διάμετρο 60. Πατάμε finish sketch. 

 Ομοίως με πριν, δημιουργούμε ένα καινούριο Datum Plane, 

παράλληλο στο ΧΥ σε απόσταση 60. (εικ 2) 
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 Πατάμε sketch, επιλέγουμε το Datum που δημιουργήσαμε, 

και σχεδιάζουμε έναν κύκλο με κέντρο που περνά από την 

αρχή των αξόνων, με διάμετρο  20. Πατάμε finish sketch 

 Ομοίως με πριν, δημιουργούμε ένα καινούριο Datum Plane, 

παράλληλο στο ΧΥ σε απόσταση 100.  

 Πατάμε sketch, επιλέγουμε το Datum που δημιουργήσαμε, 

και σχεδιάζουμε έναν κύκλο με κέντρο που περνά από την 

αρχή των αξόνων, με διάμετρο  30. Πατάμε finish sketch 

 Το μοντέλο μας είναι όπως στην εικόνα 3. 
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 Επιλέγουμε sketch, επίπεδο σχεδιασμού τον ΥΖ και 

σχεδιάζουμε ένα Line όπως στην εικόνα 4. 

 Πατάμε finish sketch (εικ 5). 
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 Επιλέγουμε την εντολή Swept  

 Στο Sections, στο Select Curve επιλέγουμε τον κατώτερο 

κύκλο της εικόνας 6. 

 Στο Sections πάλι, πατάμε Add New Set , και 

επιλέγουμε τον αμέσως επόμενο κύκλο. 

 Ξαναπατάμε Add New Set, επιλέγουμε τον επόμενο και 

ξανά επιλέγουμε Add New Set και επιλέγουμε τον τελικό 

εικ 6. 
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 Στο Guides επιλέγουμε το Select Curve και δίνουμε το Line 

που σχεδιάσαμε και περνά από το κέντρο όλων των 

κύκλων. 

 Τέλος στο section options δώστε τις επιλογές Linear, Cubic ή 

Blend ώστε να δείτε τις διαφορές. 
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Οι εντολές Trim Body και Draft 

 Επιλέγουμε sketch και επίπεδο σχεδίασης το ΧΥ 

 Σχεδιάσουμε ένα ορθογώνιο όπως στην εικόνα 1 και 

πατάμε finish sketch. 

 Κάνουμε extrude το ορθογώνιο με distance 40 (εικ 2). 
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 Επιλέγουμε τώρα την εντολή Trim Body  

 Στο Target επιλέγουμε το μοντέλο που δημιουργήσαμε 

 Στο tool option επιλέγουμε new plane και διαλέγουμε την 

πλευρά της εικόνας 3. 

 Δίνουμε Distance -10. (εικ 4). 

 Πατάμε ΟΚ και το μοντέλο είναι όπως στην εικόνα 5. 
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 Τώρα επιλέγουμε την εντολή draft. 

 Στο Draw Direction, στο Specify Vector επιλέγουμε τον 

άξονα Ζ. 

 Στο Draft References και στο Select Stationary Faces 

επιλέγουμε τις τέσσερις πλευρές του παραλληλεπιπέδου 

όπως βλέπουμε στην εικόνα 6. 

 Στο faces to draft επιλέγουμε την πλευρά της εικόνα 7. 

 Δίνουμε Angle 40 και το μοντέλο είναι όπως στην εικόνα 8 
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Χρήσεις της εντολής Pattern 

 Πατάμε sketch, επιλέγουμε το YZ Datum Plane και 

σχεδιάζουμε ένα ορθογώνιο με ακμές 200 και 10 (εικ 1) 

 Πατάμε Finish Sketch και κάνουμε extrude στο ορθογώνιο 

για 200.  

 Πατάμε πάλι sketch και επιλέγουμε την κόκκινη πλευρά της 

εικόνας 2 

 Σχεδιάζουμε έναν κύκλο όπως στην εικόνα 3 και πατάμε 

finish sketch. 

 Κάνουμε extrude για 50 και το μοντέλο μας είναι όπως στην 

εικόνα 4. 
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1) Pattern σε ευθεία γραμμή 

 

 Στο feature to Pattern όπως έχουμε ξαναδεί πρέπει να 

επιλέξουμε το κομμάτι που θα κάνουμε Pattern, στην 

συγκεκριμένη περίπτωση είναι ο κύλινδρος. 

 Στο Pattern Definition στο Layout επιλέγουμε Linear 

(γραμμικό) 

 Στο Specify Vector επιλέγουμε το διάνυσμα με βάση το 

οποίο θα γίνει το Pattern. Επιλέγουμε το Υ-Axis. 

 To εικονίδιο αυτό  το χρησιμοποιούμε για να 

αλλάξουμε την κατεύθυνση του Pattern 

 Ας δούμε τώρα το Spacing. H πρώτη επιλογή είναι το Count 

and Pitch δηλαδή πόσους κυλίνδρους θα δημιουργήσω 

(Count) και τι απόσταση θα έχουν μεταξύ τους pitch. 

 H δεύτερη επιλογή είναι το Count and Span δηλαδή 

πόσους κυλίνδρους θα δημιουργήσω (Count) σε πόσo 

μήκος (Span), δηλαδή πόσο θα απέχει ο πρώτος από τον 

τελευταίο κύλινδρο. 

 Η Τρίτη επιλογή είναι το Pitch and Span. Εδώ δεν δίνουμε 

αριθμό των κυλίνδρων αλλά την απόσταση των διαδοχικών 

κυλίνδρων (Pitch) και το συνολικό μήκος του Pattern 

(Span). 

  Με την επιλογή List μπορούμε να κάνουμε Pattern των 

κυλίνδρων που δεν απέχουν ίση απόσταση μεταξύ τους 

δίνοντας το Count και το Spacing. 

 Δείτε στις παρακάτω εικόνες το ίδιο αποτέλεσμα Pattern 

με 3 διαφορετικούς τρόπους. 
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2) Pattern σε κυκλικό οδηγό 

 

 Αλλάζουμε τις αποστάσεις του κυλίνδρου από τους 

άξονες όπως στην εικόνα 1. 

 Επιλέγουμε Pattern Feature. Στο Select Feature 

επιλέγουμε όπως και πριν τον κύλινδρο. 

 Στο Layout επιλέγουμε Circular. 

 Στο Specify Vector επιλέγουμε τον άξονα περιστροφής 

του κυκλικού Pattern που εδώ είναι ο άξονας Ζ. 

 Στο Specify Point διαλέγουμε το σημείο γύρω από το 

οποίο θα γίνει το Pattern. Εδώ επειδή αναλύουμε την 

εντολή και τις διάφορες λειτουργίες της θα διαλέξουμε 

ένα τυχαίο σημείο επιλέγοντας Cursor Location . 

 Στο Spacing έχουμε τις ίδιες επιλογές που είχαμε 

προηγουμένως μόνο που εδώ μετράμε με βάση τις 

μοίρες 

 Δείτε το ίδιο Pattern με διαφορετικά Spacing.  
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3) Pattern πάνω σε τυχαίο οδηγό 

 

 Επιλέγουμε sketch και διαλέγουμε την πλευρά που είναι 

τοποθετημένος ο κύλινδρος. 

 Σχεδιάζουμε ένα τυχαίο σχήμα όπως πχ αυτό της εικόνας 

1. 

 Επιλέγουμε το Pattern Feature. Στο Select Curve 

επιλέγουμε τον κύλινδρο. 

 Στο Layout επιλέγουμε Along και στο Select Path κάνουμε 

κλικ την γραμμή-καμπύλη που σχεδιάσαμε. 

 Οι επιλογές στο Spacing είναι ίδιες με πριν. Στο location 

έχουμε τις επιλογές, Arc Length, %Arc Length.  

 Αν επιλέξουμε Count and Pitch και Arc Length ορίζουμε 

σε mm την απόσταση  των διαδοχικών Pattern 

 Αν επιλέξουμε Count and Picth και %Arc Length ορίζουμε 

σε ποσοστιαία μονάδα του συνολικού Path, την 

απόσταση που θα έχουν τα διαδοχικά Pattern. 

 Αντίστοιχα λειτουργούν και οι υπόλοιπες εντολές. 

Πειραματιστείτε αλλάζοντάς τες για την καλή κατανόηση 

τους αλλά και για να αποκτήσετε ευχέρεια στην σωστή 

χρήση του Pattern Feature. 

 Αν θέλαμε η οπή να γίνει μέχρι ενός σημείου μέσα στο 

σώμα του αντικειμένου θα δίναμε τις αντίστοιχες τιμές 

στο Value. 
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TUTORIAL 2 

1) Δημιουργία πρώτου part (Piston.prt) 
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 Καθώς ανοίγετε το πρόγραμμα και ορίζετε το working 

directory στον φάκελο με το όνομά σας, δώστε το όνομα 

piston.prt στο μοντέλο που θα σχεδιάσουμε τώρα. 

 Επιλέξτε sketch και datum plan το ΥΖ και σχεδιάστε το 

σχήμα της εικόνας 1. Προσέξτε ότι στο πάνω μέρος του 

σχεδίου δεν είναι γραμμή (Line) αλλά καμπύλη (Arc).  

 Τελειώστε το sketch πατώντας finish sketch και κάντε 

Revovle με specify vector την γραμμή p1 που της εικόνας 1. 

 Tώρα κάντε ένα Shell με thickness 10 στο κάτω μέρος το 

αντικειμένου (εικ 2). 
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 Δημιουργείστε ένα νέο Datum Plane παράλληλο στο Datum 

XZ και σε απόσταση 50 από αυτό. Επιλέξετε sketch και 

datum σχεδίασης το datum που μόλις φτιάξατε. 

 Σχεδιάστε ένα ημικύκλιο ακτίνας 25, και ενώστε τα άκρα 

του ημικυκλίου με μια γραμμή,  όπως στην εικόνα 3. 

 Επιλέξτε extrude και θα σας εμφανιστεί κάτι όπως στην 

εικόνα 4. Κάντε διπλό κλικ στο μπλε βελάκι ώστε να 

αλλάξετε την κατεύθυνση του extrude και στο Boolean 

επιλέξτε Subtract για να αφαιρέσετε υλικό. 

 Το αντικείμενο μας είναι όπως στην εικόνα 5.  
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 Κάντε τώρα Edge Blend ακτίνας 5, στις ακμές που βλέπετε 

στην εικόνα 6. 

 Επιλέγουμε τώρα sketch, και επιλέγουμε πάλι το Datum 

που δημιουργήσαμε προηγουμένως. Σχεδιάζουμε έναν 

κύκλο ακτίνας 30 όπως στην εικόνα 7. 

 Κάνουμε πάλι extrude με subtract ακριβώς όπως κάναμε 

προηγουμένως με το ημικύκλιο. 

 Το αντικείμενο μας είναι σαν αυτό της εικόνας 8.  
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 Τώρα θα κάνουμε ένα sketch πάνω στην γραμμή που 

σχεδιάσαμε αρχικά για το revolve. Πατάμε sketch και 

επιλέγουμε στο sketch type την επιλογή on path και εκεί 

επιλέγουμε την πράσινη ακμή που βλέπετε στην εικόνα 10. 

Τώρα κάνουμε κλικ στο specify vector και εμφανίζονται τα 

μωβ βελάκια. Πατώντας κλικ πάνω τους ορίζουμε το 

επίπεδο που θα σχεδιάσουμε. Επιλέξτε το Χ. 

(Συμβουλευτείτε την εικόνα 9 με προσοχή). 
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 Σχεδιάζουμε 3 ορθογώνια με πλευρές 4 και 3 και απόσταση 

2 μεταξύ τους. Συμβουλευτείτε τις εικόνες 10 και 11 και 

δώστε προσοχή στις διαστάσεις. 
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 Πατάμε finish sketch και τώρα θα κάνουμε revolve με 

αφαίρεση υλικού στα τρία ορθογώνια που σχεδιάσαμε. 

 Πατάμε revolve. Τα ορθογώνια δεν τε βλέπετε για να 

πατήσετε κλικ πάνω τους και να τα επιλέξετε για το revolve 

αλλά μπορείτε να τα επιλέξετε κάνοντας κλικ πάνω στο 

sketch τους, που μόλις ολοκληρώσατε, στην καρτέλα με τις 

εντολές. Επιλέξτε το μωβ βέλος που βλέπετε στην εικόνα 12 

για άξονα περιστροφής του revolve και μην ξεχάσετε να 

επιλέξετε subtract στο Boolean. 

 To αντικείμενό μας είναι όπως στην εικόνα 13 και είναι 

έτοιμο. Κάντε του save και κλείστε το.  
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2) Δημιουργία του Pin.prt 
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 Καθώς ανοίγετε το πρόγραμμα και ορίζετε το working 

directory στον φάκελο με το όνομά σας, δώστε το όνομα 

pin.prt στο μοντέλο που θα σχεδιάσουμε τώρα. 

 Ανοίχτε το sketch επιλέγοντας datum σχεδιασμού το ΥΖ. 

 Με την επιλογή Line σχεδιάστε αυτό που βλέπετε στην 

εικόνα 1. 

 Πατήστε finish sketch και κάντε Revolve το σχήμα που 

φτιάξατε με specify vector την κάτω οριζόντια ακμή. 

 Επιλέξτε την κατάλληλη επιφάνεια και κάντε ένα Shell με 

Thickness 5 ώστε το αντικείμενο να είναι όπως στην εικόνα 

2.  

 Δώστε, αν θέλετε, ένα χρώμα στο αντικείμενο (βλ tutorial 1) 

 To αντικείμενό μας είναι έτοιμο (εικ 2). 
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 Επιλέγουμε τώρα το sketch και διαλέγουμε την επιφάνεια 

της εικόνας 3. 

 Σχεδιάζουμε έναν κύκλο διαμέτρου 20. 

 Κλείνουμε το sketch και κάνουμε extrude με distance 15 και 

με subtract (εικ 4) 

 Το αντικείμενο ολοκληρώθηκε (εικ 5). Αν στην εντολή Shell 

επιλέγατε τις δύο επιφάνειες ταυτόχρονα δεν θα 

χρειαζόταν να κάνετε εκ νέου sketch και extrude. 

 Κάντε save και κλείστε το παράθυρο. 
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3) Δημιουργία του Rod.prt  
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 Καθώς ανοίγετε το πρόγραμμα και ορίζετε το working 

directory στον φάκελο με το όνομά σας, δώστε το όνομα 

rod.prt. 

 Επιλέγουμε sketch και διαλέγουμε datum plane το ΥΖ. 

 Σχεδιάστε ότι βλέπετε στην εικόνα 1  

 Τελειώστε το sketch και κάντε extrude με Start Distance 0 

και End Distance 20. (εικ 2) 
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 Τώρα θα χρειαστεί αν σχεδιάσουμε κάτι πάνω στο ήδη

επεξεργασμένο αντικείμενο.

 Πατάμε sketch και επιλέγουμε datum σχεδίασης το YZ.

 Σχεδιάζουμε δύο καμπύλες με Arc όπως στην εικόνα 3.

 Ενώνουμε τα σημεία με Line όπως στην εικόνα 4.

Πατάμε finish sketch και κάνουμε extrude με distance 20

(εικ 4).
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 Επιλέγουμε τώρα την εντολή Unite  και 

«ενώνουμε» τα τρία κομμάτια του αντικειμένου μας. 

 Το αντικείμενό μας είναι όπως στην εικόνα 5. 

 Κάνουμε τώρα τέσσερα Edge Blend με ακτίνα 20. (εικ 6). 

 Το αντικείμενό μας είναι έτοιμο *εικ 7). Κάνουμε save και 

το κλείνουμε. 
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4) Δημιουργία του Shaft.prt 
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 Καθώς ανοίγετε το πρόγραμμα και ορίζετε το working

directory στον φάκελο με το όνομά σας, δώστε το όνομα

shaft.prt.

 Επιλέγουμε sketch και datum plane το ΧΖ.

 Σχεδιάζουμε έναν κύκλο με κέντρο την αρχή των αξόνων

και διάμετρο 100. Ολοκληρώνουμε το sketch και του

κάνουμε extrude για 10.

 Επιλέγουμε την εντολή Hole. Κάνουμε κλικ στην μεγάλη

επιφάνεια του κύκλου για να δώσουμε το κέντρο του Hole

και δίνουμε τις τιμές των αποστάσεων της εικόνας 1.

 Δίνουμε διάμετρο 10 και επιλέγουμε Through body. Το

Through body σημαίνει πως η οπή θα γίνει κατά μήκος του

σώματος του αντικειμένου που την κάνουμε χωρίς να

χρειάζεται να δώσουμε εμείς το βάθος της (depth) (εικ 2)
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 Τώρα θα κάνουμε ένα κυκλικό Pattern στην οπή αυτή 

 Επιλέγουμε το Pattern Feature 

 Στο Select Feature επιλέγουμε την οπή. Στο Layout βάζουμε 

circular.  

 Στο Specify vector επιλέγουμε τον άξονα Υ.  

 Στο Specify Point κλικάρουμε το δεξί εικονίδιο, επιλέγουμε 

το εικονίδιο του κύκλου και μετά επιλέγουμε τον πορτοκαλί 

κύκλο της εικόνας. 

 Τέλος επιλέγουμε Count and Span, Count = 12 και Span 

Angle = 360 deg. 

 Συμβουλευτείτε την εικόνα 3. 

 Πατάμε ΟΚ για να ολοκληρωθεί το Pattern. 

 Τώρα επιλέγουμε πάλι sketch και κάνουμε κλικ στην 

πλευρά του αντικειμένου. Προσοχή! Δεν είναι η όψη που 

βλέπετε όταν πατάτε Home για να δείτε το αντικείμενο, 

αλλά η άλλη. (εικ 4) 
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 Σχεδιάζουμε έναν κύκλο με ίδιο κέντρο την αρχή των 

αξόνων, με διάμετρο 40. Τελειώνουμε το sketch και 

κάνουμε extrude για 40. (Εικ 5) 

 Επιλέγουμε πάλι sketch και επιλέγουμε την επιφάνεια που 

βλέπετε στην εικόνα 6. 

 Σχεδιάζουμε ότι βλέπετε στην εικόνα 7. Όταν το 

ολοκληρώσουμε κλείνουμε το sketch. 

 Κάνουμε extrude για 10 αυτό που σχεδιάσαμε. 
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 Επιλέγουμε πάλι sketch και διαλέγουμε datum το ΥΖ. 

 Σχεδιάζουμε με την εντολή Profile ή Line ότι βλέπουμε στην 

εικόνα 8 και όταν τελειώσουμε πατάμε finish sketch. 

 Πατάμε το Revolve, επιλέγουμε το curve που σχεδιάσαμε 

με specify vector την κάτω οριζόντια ακμή. 

 Κάνουμε Unite τα κομμάτια που σχεδιάσαμε και 

ολοκληρώνουμε την εργασία μας γι’ αυτό το αντικείμενο 

(εικ 9). 

 Κάνουμε save και κλείνουμε το μοντέλο. 
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TUTORIAL 3      

Η συναρμολόγηση του τελικού μοντέλου 

86



 Στα προηγούμενα tutorial σχεδιάζαμε μοντέλα. Για να μπούμε 

στο παράθυρο σχεδίασης επιλέγαμε File → New → Model. 

Τώρα που θα κάνουμε την συναρμολόγησή τους θα επιλέξουμε 

File → New → Assembly (εικ 1). 

 Δίνουμε το όνομα assembly1.prt και τον φάκελο που έχουμε 

αποθηκεύσει τις προηγούμενες εργασίες μας. 

 Είμαστε έτοιμοι να ξεκινήσουμε την πρόσθεση των κομματιών 

για το Assembly. (εικ 2) 
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 Μπορείτε να δουλεύετε από την καρτέλα Home ή την

καρτέλα Assemblies.

 Όπως βλέπετε είναι ανοιχτό ένα παράθυρο με όνομα Add

Component. Σε περίπτωση που το κλείσατε ή δεν είναι

ανοιχτό μπορείτε να ανοίξετε ένα νέο παράθυρο Add

Component με την εντολή Add . (εικ 3)

 Πατάμε το εικονίδιο του Open  και ανοίγει ένα νέο 

παράθυρο που περιλαμβάνει τα προηγούμενα μας

μοντέλα. Εμείς τώρα θα επιλέξουμε το Shaft.

 Αφήνουμε την επιλογή «By constraints”. Πατάμε ΟΚ στο

παράθυρο “Add Component” και πάλι ΟΚ στο παράθυρο

“Assembly Constraints”.  Έτσι το αντικείμενό μας

τοποθετείτε με τους με βάση τους άξονες που το

σχεδιάσαμε. (εικ 4).

 Τώρα είμαστε έτοιμοι να βάλουμε το επόμενο κομμάτι.

Πατάμε Add → Open και επιλέγουμε το Rod. Αφήνουμε την

επιλογή By Constraints και πατάμε ΟΚ στο παράθυρο Add

Component.

 Αν κάνετε δύο φορές κλικ στο “Preview Component in Main

Window” θα εξαφανίσει το Rod από το μεγάλο παράθυρο

εργασίας.

 Τώρα θα συναρμολογήσουμε τα δύο αντικείμενα Shaft και

Rod.

3 

4 

88



 Στο Constraint Type υπάρχουν διάφορες επιλογές για την 

τοποθέτηση του αντικειμένου.  

Τώρα θα επιλέξουμε Touch Align . 

 Στο Orientation επιλέγουμε Infer Center/Axis. 

 Τώρα πρέπει να επιλέξουμε δύο άξονες. Διαλέγουμε 

αυτούς που βλέπετε, με κόκκινο χρώμα στις εικόνες 5 και 6. 

 Πατάμε Preview Component in Main Window αν δεν 

βλέπουμε το Rod και βλέπουμε ότι το Rod έχει τοποθετηθεί 

αλλά όχι εκεί που θέλουμε (εικ 7). 
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 Πρέπει δηλαδή να δώσουμε κι άλλες πληροφορίες για το 

assembly.Στο Type επιλέγουμε Distance . 

 Επιλέγουμε τις πλευρές που βλέπετε με κόκκινο χρώμα στις 

εικόνες 8 και 9. 

 Δίνουμε τιμή του Distance 10 και πατάμε ΟΚ 

 Το μοντέλο μας είναι όπως στην εικόνα 10. 
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 Τώρα θέλουμε να αλλάξουμε την κατεύθυνση του Rod. 

Αυτό μπορούμε να το κάνουμε με δύο τρόπους. Ο πρώτος 

και ο πιο πρακτικός είναι ο εξής: Πατάμε δεξί κλικ πάνω του 

και επιλέγουμε Move. Παρατηρούμε ότι πάνω στο 

αντικείμενο εμφανίστηκαν κάποιοι άξονες και καμπύλες 

μεταξύ τους(εικ 11). Επιλέγουμε τον την καμπύλη μεταξύ 

των αξόνων ZC και YC και κρατώντας πατημένο το αριστερό 

κλικ περιστρέφουμε το Rod. (Οι αριθμοί που βλέπετε στην 

εικόνα 11 είναι τυχαίοι 

 Περιστρέφουμε το Rod ώστε να έρθει σε κατακόρυφη θέση 

όπως στην εικόνα 12. 

 Αυτός ήταν ένας πρακτικός τρόπος για να αλλάξουμε την 

θέση κάποιων αντικειμένων στο Assembly. Ας δούμε έναν 

διαφορετικό πιο αξιόπιστο τρόπο. 

 Πατήστε Undo  ώστε να έρθει το Rod στην αρχική του 

θέση όπως στην εικόνα 10 
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 Τώρα κάνουμε δεξί κλικ πάνω στο Rod και επιλέγουμε

Replace Reference Set → Entire Part.

 Κάνουμε δεξί κλικ στο Shaft και επιλέγουμε και εκεί

Replace Reference Set → Entire Part.

 Όπως βλέπετε έχουν εμφανιστεί τα επίπεδα ΧΥ, ΧΖ, ΥΖ στα

αντικείμενα.

 Ανοίγουμε την καρτέλα του Assembly Navigator, κάνουμε

δεξί κλικ στο rod και επιλέγουμε Assembly Constraints (εικ

13) ή επιλέγουμε την εντολή Assembly Constraints . 

 Επιλέγουμε Touch Align στο Type και Align 

στο Orientation.

 Προσοχή στην σωστή επιλογή των Planes. Επιλέγουμε το ΧΥ

του Rod και μετά επιλέγουμε το ΥΖ του Shaft.

 Δίνουμε τιμή 0 στο Distance και πατάμε ΟΚ.

 Το αντικείμενό μας είναι όπως στην εικόνα 14.

 Αντί για το Align μπορούσαμε επίσης να χρησιμοποιήσουμε

την εντολή  Parallel .
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 Τώρα θα τοποθετήσουμε το επόμενο αντικείμενο. Πατάμε

Add μετά Open και επιλέγουμε το αντικείμενο Pin.

 Αφήνουμε την επιλογή By Constraints και πατάμε ΟΚ στο

παράθυρο.

 Στο Type επιλέγουμε Touch Align και στο Orientation

επιλέγουμε Infer Center/Axis.

 Επιλέγουμε τους άξονες που βλέπετε με κόκκινο χρώμα

στις εικόνες 15 και 16.

 Τώρα στο Type επιλέγουμε Distance και επιλέγουμε τις

επιφάνειες που βλέπετε στις εικόνες 17 και 18 και δίνουμε

την τιμή 20 στο Distance.

 Πατάμε ΟΚ στο παράθυρο και το αντικείμενό μας είναι

όπως στην εικόνα 19.
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 Τώρα θα τοποθετήσουμε το τελευταίο αντικείμενο στο 

Assembly που είναι το Piston. 

 Επιλέγουμε Add, Open και διαλέγουμε το Piston. Αφήνουμε 

την επιλογή By Constraints και πατάμε ΟΚ στο παράθυρο. 

 Στο Type επιλέγουμε Touch Align και στο Orientation 

επιλέγουμε Infer Center/Axis. 

 Διαλέγουμε τους άξονες που βλέπετε στις εικόνες 20 και 21 

και πατάμε ΟΚ στο παράθυρο. 

 Τώρα θα κάνουμε ότι κάναμε προηγουμένως. Κάνουμε δεξί 

κλικ πάνω στο Pin και επιλέγουμε Replace Reference Set → 

Entire Part ώστε να εμφανιστούν τα Datum Planes του 

αντικειμένου. 

 Κάνουμε δεξί κλικ στο Piston και επιλέγουμε και εκεί 

Replace Reference Set → Entire Part. 

 Ανοίγουμε την καρτέλα του Assembly Navigator κάνουμε 

δεξί κλικ στο Piston και επιλέγουμε Assembly Constraints 

 Επιλέγουμε Touch Align στο Type και Align στο Orientation. 

 Επιλέγουμε το ΧΖ Datum στο Piston και το ΧΖ στο Pin. 

 Πατάμε OK και το μοντέλο μας έχει πάρει την τελική του 

μορφή όπως στην εικόνα  22. 

 Σε περίπτωση που θέλετε να περιστρέψετε ένα αντικείμενο 

σε σχέση με κάποιο άλλο μπορείτε να χρησιμοποιήσετε 

επίσης την εντολή Angle   
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 Σημείωση: Υπάρχει περίπτωση να κάνουμε λάθη κατά την

διάρκεια του Assembly ή να θελήσουμε να αλλάξουμε

κάποια από τις εντολές συναρμολόγησης, δηλαδή τα

Assembly Constraints.

 Στην αριστερή καρτέλα, έχοντας επιλεγμένο το Assembly

Navigator κάνουμε κλικ στο + που υπάρχει δίπλα στο

Constraints και έτσι εμφανίζονται όλες οι εντολές

συναρμολόγησης που έχουμε δώσει (εικ 23, 24).

 Κάνοντας δεξί κλικ πάνω σε ένα Constraint εμφανίζονται

διάφορες επιλογές για να το αλλάξουμε ή ακόμα και να το

διαγράψουμε (εικ 25).
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 Σημείωση: Είναι πολύ πιθανόν κατά την διάρκεια σχεδιασμού 

των αντικειμένων να γίνει κάποιο λάθος στις δημιουργία τους 

και στην διαστασιολόγησή τους. Αυτό αρχικά μπορεί να μην γίνει 

αντιληπτό αλλά να δημιουργήσει πρόβλημα στο Assembly. 

 H εντολή που θα ελέγξει το μοντέλο μας είναι η Clearance 

Analysis  . Επιλέγουμε αυτή την εντολή στην συνέχεια 

επιλέγουμε New Set και πατάμε ΟΚ στο παράθυρο που μας 

εμφανιστεί.  

 Στην συνέχεια θα γίνει η ανάλυση του μοντέλου μας και θα 

εμφανιστεί ένα νέο παράθυρο το Clearance Browser στο οποίο 

θα εμφανίζονται τα Interferences. To Clearance Browser είναι 

όπως στην εικόνα 26. 

 Το εικονίδιο αυτό  μας δείχνει ότι κάποια αντικείμενα είναι σε 

επαφή και αν κάνουμε κλικ στα κουτάκια αριστερά αυτά θα 

φαίνονται με κόκκινες τελείες πάνω στο μοντέλο (εικ 27). 

 Σε περίπτωση που σε ένα Clearance Browser εμφανιστεί αυτό το 

εικονίδιο  σημαίνει πώς έχουμε κάνει λάθος στην 

συναρμολόγηση και το ένα αντικείμενο “πέφτει πάνω στο άλλο”, 

συμβαίνει κάτι δηλαδή όπως στην εικόνα 28. Αυτό σημαίνει πως 

έχουμε κάνει λάθος στο Assembly ή στην σχεδίαση των 

αντικειμένων και πρέπει να κάνουμε αλλαγές.  
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TUTORIAL 4 

 

Τα Drafting 

 
 Ανοίγουμε το πρόγραμμα και επιλέγουμε File→Open 

και επιλέγουμε το πρώτο μοντέλο που σχεδιάσαμε, 

αυτό δηλαδή της εικόνας 1 και πατάμε ΟΚ. 

 Δεν κάνουμε κάποια αλλαγή στο μοντέλο μας. 

 Κάνουμε κλικ στο βασικό Tab την επιλογή Application 

και επιλέγουμε το Drafting  

 Επιλέγουμε το A3 Size στο παράθυρο που εμφανίστηκε 

και πατάμε ΟΚ. 

 Βρισκόμαστε στο Drafting και καλούμαστε να 

συμπληρώσουμε κάποια στοιχεία για το drafting. Σε 

αυτή την φάση δεν θα συμπληρώσουμε κάτι γι’ αυτό 

κλείστε τα παράθυρα που θα σας εμφανιστούν έτσι  

ώστε το παράθυρο εργασίας σας να είναι όπως στην 

εικόνα 2. 
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 Τώρα θα βάλουμε τις 3 βασικές όψεις του αντικειμένου

αλλά και την trimetric.

 Κάντε κλικ στην επιλογή Base View

 Στο Model View to Use επιλέγουμε Front και στο scale 1:2

ώστε να χωράει στο χαρτί. Το Scale μπορεί να διαφέρει

αναλόγως το μοντέλο.

 Τοποθετούμε την πρόοψη στο πάνω αριστερά μέρος του

χαρτιού σύροντας τον κέρσορα στο σημείο που θέλουμε

και πατώντας μία φορά αριστερό κλικ. Κλείνουμε το

παράθυρο Projected View.

 (εικ 3).

 Πατάμε πάλι στην επιλογή Base View. Αυτή την φορά

επιλέγουμε Top στο Model View to Use και πάλι βάζουμε

στο Scale 1:2. Τοποθετούμε το σχέδιο στο κάτω αριστερά

μέρος. (εικ 4). Προσέξτε κατά την διάρκεια που σύρετε το

σχέδιο πάνω στο χαρτί να εμφανιστεί η πορτοκαλί αξονική

για να σας βοηθήσει στην σωστή τοποθέτηση του σχεδίου

σε σχέση με την πρόοψη.
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 Ομοίως κάνουμε και για τις άλλες δύο όψεις. 

 Για την αριστερή πλάγια όψη χρησιμοποιούμε την επιλογή 

Left στο Model View to Use και τοποθετούμε το σχέδιο 

πάνω δεξιά. (εικ 5) 

 Για την τριμετρική όψη του μοντέλου χρησιμοποιούμε την 

επιλογή Trimetric στο Model View to Use και τοποθετούμε 

το σχέδιο στο κάτω δεξιά μέρος. 

 Μην ξεχάσετε και στις δύο περιπτώσεις να προσαρμόσετε 

το scale σε 1:2. (εικ 6).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5 

6 

99



 Για την διαστασιολόγηση των σχεδίων επιλέγουμε την 

εντολή Rapid (D)  ή τις επιλογές που έχει δεξιά από 

αυτή την εντολή. 

 Καθώς επιλέξουμε την εντολή ή πατήσουμε D στο 

πληκτρολόγιο πάμε σε μία πλευρά πάνω στο σχέδιο και 

κάνουμε μία φορά αριστερό κλικ. Εμφανίζεται η διάσταση 

της, την κινούμε τον κέρσορα σε ένας σημείο που να 

φαίνεται καλά και ξαναπατάμε αριστερό κλικ. (εικ 7).  

 Την διάσταση που βλέπετε μπορούμε να την 

τοποθετήσουμε και με άλλον τρόπο κάνοντας αριστερό κλικ 

στις δύο κάθετες ακμές (εικ 8). 

 Ομοίως τοποθετούμε όλες τις διαστάσεις . 

 Προσοχή μην τοποθετήσετε μια διάσταση δύο φορές. 

 Στην τριμετρική όψη του μοντέλου δεν τοποθετούμε 

διαστάσεις. 

 Ολοκληρώνετε το Drafting και κάνετε save στο αρχείο. Στην 

καρτέλα του Application μπορείτε να αλλάζετε το Drafting 

με το Modeling το ίδιου αντικειμένου που επεξεργάζεστε. 
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 To ολοκληρωμένο Drafting για το Model 1 φαίνεται  

στην παρακάτω εικόνα. 
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          Το Exploded View και τα Balloons 

 
 To Exploded View είναι μια λειτουργία των 

προγραμμάτων CAD με τα οποία δείχνουμε σε ένα 

μηχανολογικό σχέδιο τα μέρη (parts) ενός Assembly 

απομακρυσμένα το ένα από το άλλο ώστε να 

φαίνονται καθαρά. Είναι μια εξίσου σημαντική 

λειτουργία ιδίως για περίπλοκες κατασκευές. 

 Ανοίξτε με File→Open το αρχείο Assembly που 

δημιουργήσατε στο προηγούμενο Tutorial. Στην 

κατακόρυφη καρτέλα στο αριστερά μέρος του 

προγράμματος επιλέγουμε το Part Navigator. 

Επιλέγουμε Model Views. Κάνουμε δεξί κλικ πάνω 

στο Model Views και επιλέγουμε Add New και 

δίνουμε το όνομα Explosion 1. (εικ 1) 

 Επιλέγουμε στο βασικό Tab την επιλογή Assemblies. 

Αν δεν βλέπετε αυτή την επιλογή κάντε δεξί κλικ σε 

ένα κενό μέρος του Tab και τσεκάρετε την επιλογή 

Assemblies. (εικ 2) 

 Καθώς επιλέγουμε την καρτέλα Assemblies πατάμε 

στην εντολή Exploded Views , επιλέγουμε New 

Explosion, δίνουμε το όνομα που υπάρχει ως 

προεπιλογή και πατάμε ΟΚ. 

 Πατάμε πάλι Exploded Views και τώρα επιλέγουμε 

Edit Explosions. 
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 Όπως βλέπετε άνοιξε ένα νέο μικρό παράθυρο για το Edit 

Explosions. Σε αυτό υπάρχουν οι επιλογές Select και Move 

Objects. Εσείς θα ακολουθείτε την εξής διαδικασία:  

1) Θα τσεκάρετε το Select Objects.  

2) Θα επιλέγετε το αντικείμενο που θέλετε.  

3) Θα τσεκάρετε το Move Objects και θα μετακινείτε το 

αντικείμενο σε σημείο τέτοιο ώστε να φαίνεται πιο καθαρά. 

Προσέξετε πως κάθε φορά που κάνετε Select πρέπει να 

τσεκάρετε ή να αφαιρείτε τα αντικείμενα που θέλετε να 

κάνετε Move από το Assembly Navigator. 

 Θέλουμε να φέρουμε τα αντικείμενα του μοντέλου σε 

τέτοια θέση ώστε να φαίνονται καθαρά όπως στις εικόνες 3 

και 4. 
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 Επιλέγουμε τώρα Applications από το βασικό Tab και 

επιλέγουμε Drafting, A4 size και κλείνουμε το παράθυρο 

που μας λέει να συμπληρώσουμε τα κενά και κλείνουμε και 

το επόμενο. 

Επιλέγουμε το Base View και στο Model View to Use 

επιλέγουμε το Explosion 1 και το τοποθετούμε στο 

αριστερό μέρος το Drafting.  

 Επιλέγουμε τώρα Parts List.  και πατάμε κλικ στο 

σημείο που βλέπετε στην εικόνα 5 ώστε να εμφανιστεί ο 

πίνακας με τα μέρη του μοντέλου. 

 O πίνακας έχει 3 στήλες με τον αριθμό του αντικειμένου 

(PC NO), το όνομά του (PART NAME) και με το πόσες φορές 

εμφανίζεται (QUANTITY). 

 Στον πίνακα μπορείτε να προσθέσετε στήλες με άλλες 

επιλογές αλλά σε αυτό το εγχειρίδιο δεν θα τις αναλύσουμε 

περεταίρω. 
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 Τέλος κάνουμε κλικ στην επιλογή Auto Balloon  και 

κάνουμε κλικ πάνω στον πίνακα που δημιουργήσαμε 

προηγουμένως. 

 Πατάμε ΟΚ στο παράθυρο και όπως βλέπετε στην εικόνα 6 

προστέθηκαν στο exploded view οι αριθμοί των 

αντικειμένων. 
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TUTORIAL 5 

ΔΗΜΙΟΥΡΓΙΑ ΤΟΥ MOTION SIMULATION 

 

 Aνοίγοντας το πρόγραμμα πατάμε File→Open→Assembly, 

το Assembly του εμβόλου που είχαμε δημιουργήσει στα 

προηγούμενα tutorial. 

 Επιλέγουμε το tab του Application και κάνουμε κλικ στο 

Motion . 

 Στην αριστερή καρτέλα κάνουμε κλικ πάνω στο όνομα του 

αρχείου (assembly), επιλέγουμε New Simulation. (εικ 1) 

 Δίνουμε τις επιλογές που βλέπετε στην εικόνα 2 και πατάμε 

ΟΚ. 

 Στον πίνακα της εικόνας 3 πατάμε cancel. 
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 Έχοντας επιλέξει την καρτέλα Home επιλέγουμε την εντολή 

Link . Κάνουμε κλικ πάνω στο shaft, δίνουμε το όνομα 

shaft στο Link και πατάμε Apply (εικ 4). Μετά κάνουμε κλικ 

πάνω στο rod, δίνουμε το όνομα rod και πατάμε Apply (εικ 

5). Τέλος πατάμε πάνω και στο piston και στο pin, δίνουμε 

το όνομα link3 και πατάμε ΟΚ (εικ 6,7). 
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 Πάλι βρισκόμενοι στην καρτέλα του Home επιλέγουμε την 

εντολή Joint  με την οποία θα δηλώνουμε το είδος της 

κίνησης κάθε μέρους του μοντέλου. 

 Επιλέγουμε Joint, στο Type επιλέγουμε Revolute 

(περιστροφική κίνηση). 

 Στον τομέα του Action Specify Origin επιλέγουμε 

Arc/Eclipse/Sphere Center . Πατάμε πάνω στο Select 

Link ώστε να δώσουμε το Link της κίνησης και κάνουμε κλικ 

στον κύκλο που βλέπετε στην εικόνα 8.  

 Επιλέγουμε τώρα την καρτέλα του Driver. Στις επιλογές 

διαλέγουμε Polynomial και στο Initial Velocity δίνουμε την 

τιμή 100 deg/turn. Πατάμε ΟΚ. 

 Το βελάκι της περιστροφής έχει εμφανιστεί πάνω στο shaft. 

(εικ 9).  
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 Αν δεν το έχετε ήδη κάνει, στην αριστερή καρτέλα όπου 

είναι το Motion Navigator κάντε κλικ στο συν (+) στα 

Links και στα Joints. (εικ 10) Θα χρειαστεί κάποια 

αντικείμενα να τα “κρύψουμε” για την επιλογή των 

Link. 

 Επιλέγουμε πάλι την εντολή Joint. Αυτή την φορά το 

Type θα είναι Universal. 

 Ξεμαρκάρουμε το shaft ώστε να μην εμφανίζεται 

(πατάμε στο κόκκινο βέλος του shaft βλ. εικ 11). 

 Στοn τομέα του Action προσέχουμε το Specify Origin να 

είναι πάλι Arc/Eclipse/Sphere Center και στο Specify 

Link επιλέγουμε τον κύκλο της εικόνας 11. 

 Τώρα βρισκόμαστε στον τομέα του Base. Ως Vector 

δίνουμε τον Z-Axis (εικ 12) 

 Μαρκάρουμε το shaft ώστε να ξαναεμφανιστεί και στο 

Specify Link επιλέγουμε το Shaft. 

 Πατάμε ΟΚ. 
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 Επιλέγουμε πάλι Joint. Το Type θα είναι Spherical. 

 Ξεμαρκάρουμε το Link3 ώστε να “εξαφανιστούν” το Piston 

και το Pin. 

 Προσέχουμε το Specify Origin να είναι πάλι 

Arc/Eclipse/Sphere Center και στο Specify Link επιλέγουμε 

τον κύκλο της εικόνας 13. 

 Μαρκάρουμε το Link3 ώστε να εμφανιστούν πάλι τα 

αντικείμενα. 

 Στο Base τώρα επιλέγουμε Select Link και επιλέγουμε το 

Link3 (εικ 14).  

 Πατάμε ΟΚ. 
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 Επιλέγουμε την εντολή Joint και τώρα διαλέγουμε στο Type 

το Slider. 

 Προσέχουμε το Specify Origin να είναι πάλι 

Arc/Eclipse/Sphere Center και στο Specify Link επιλέγουμε 

τον κύκλο της εικόνας 15. 

 Με το Reverse Direction  αλλάζουμε την φορά ώστε το 

βέλος να έχει κατεύθυνση προς τα πάνω (εικ 16). 

 Πατάμε ΟΚ και σε αυτό το σημείο έχουμε δώσει όλες τις 

απαραίτητες εντολές για την κίνηση του μοντέλου. 

 

 

 

 

 

 

15 

16 

111



 Επιλέγουμε το Solution  (δίπλα στο Link) και 

εμφανίζεται το παράθυρο της εικόνας 17. 

 Δώστε τις τιμές που βλέπετε και προσέξτε να είναι 

επιλεγμένο το Solve with OK.  

 Πατήστε ΟΚ και κλείστε το παράθυρο του Information. 

 Για να κινηθεί το μοντέλο πατήστε την επιλογή Animation 

 και στην συνέχεια πατήστε Play. 
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TUTORIAL 6                                                              ΑΣΚΗΣΗ 1 
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ΑΣΚΗΣΗ 2 
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ΑΣΚΗΣΗ 3 
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ΑΣΚΗΣΗ 4 
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ΒΙΒΛΙΟΓΡΑΦΙΑ 

ΣΥΣΤΗΜΑΤΑ CAD/CAM & ΤΡΙΣΔΙΑΣΤΑΤΗ ΜΟΝΤΕΛΟΠΟΙΗΣΗ, 2η έκδοση Νικόλαος, Μπιλάλης & Εμμανουήλ 

Μαραβελάκης 

Μηχανολογικό σχέδιο, 2η έκδοση, Αριστομένης Αντωνιάδης 

https://www.plm.automation.siemens.com/en/products/nx/11/ 

https://docs.plm.automation.siemens.com/tdoc/nx/11.0.1/nx_help/#uid:index 

https://en.wikipedia.org/wiki/Siemens_NX 
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